
Learn more from Oracle University at education.oracle.com

Oracle Application Express 

Workshop I

Activity Guide – Volume II

D79653GC30 | D106874
O

ra
cl

e 
In

te
rn

al
 &

 O
ra

cl
e 

Ac
ad

em
y 

U
se

 O
nl

y



Copyright © 2019, Oracle and/or its affiliates. All rights reserved.

Disclaimer

This document contains proprietary information and is protected by copyright and 

other intellectual property laws. You may copy and print this document solely for 

your own use in an Oracle training course. The document may not be modified or 

altered in any way. Except where your use constitutes "fair use" under copyright 

law, you may not use, share, download, upload, copy, print, display, perform, 

reproduce, publish, license, post, transmit, or distribute this document in whole or in 

part without the express authorization of Oracle.

The information contained in this document is subject to change without notice. If 

you find any problems in the document, please report them in writing to: Oracle 

University, 500 Oracle Parkway, Redwood Shores, California 94065 USA. This 

document is not warranted to be error-free.

Restricted Rights Notice

If this documentation is delivered to the United States Government or anyone using 

the documentation on behalf of the United States Government, the following notice 

is applicable: 

U.S. GOVERNMENT RIGHTS

The U.S. Government’s rights to use, modify, reproduce, release, perform, display, 

or disclose these training materials are restricted by the terms of the applicable 

Oracle license agreement and/or the applicable U.S. Government contract. 

Trademark Notice

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other 

names may be trademarks of their respective owners.

Authors

Sayantani Ghosh

Moitreyee Hazarika

Technical Contributors 

and Reviewers

Suresh Rajan

Anjani Pothula

David Peake

Chaitanya Koratamaddi

Joe Greenwald

Editors

Adrita Biswas 

Aju Kumar 

Moushmi Mukherjee

Graphic Editors

Prakash Dharmalingam

Anne Elizabeth 

Pushparaj Kundar

Publishers

Pavithran Adka 

Veena Narasimhan 

Giri Venugopal

3009092019

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Oracle Application Express Workshop I – Table of Contents  iii 

Table of Contents 

 
 

Course Practice Environment: Security Credentials ....................................................................... vii 

Practices for Lesson 1: Course Overview ..................................................................................... 9 

Practices for Lesson 1: Overview ................................................................................................... 10 

Practices for Lesson 2: Oracle Application Express: Introduction ............................................. 11 

Practices for Lesson 2: Overview ................................................................................................... 12 

Practice 2-1: Using Oracle Application Express as a Workspace Administrator ............................ 13 

Practice 2-2: Using Oracle Application Express as a Developer .................................................... 14 

Practice 2-3: Installing a Sample Dataset ....................................................................................... 15 

Solution 2-1: Using Oracle Application Express as a Workspace Administrator ............................ 16 

Solution 2-2: Using Oracle Application Express as a Developer .................................................... 23 

Solution 2-3: Installing a Sample Dataset ....................................................................................... 37 

Practices for Lesson 3: Creating a Database Application ........................................................... 41 

Practices for Lesson 3: Overview ................................................................................................... 42 

Practice 3-1: Creating Database Applications ................................................................................ 43 

Practice 3-2: Creating a Database Application from a File ............................................................. 44 

Solution 3-1: Creating Database Applications ................................................................................ 45 

Solution 3-2: Creating a Database Application from a File ............................................................. 48 

Practices for Lesson 4: Working with Reports .............................................................................. 55 

Practices for Lesson 4: Overview ................................................................................................... 56 

Practice 4-1: Creating Classic Reports ........................................................................................... 57 

Practice 4-2: Creating a Column Toggle Report ............................................................................. 59 

Practice 4-3: Adding and Modifying a List View Report .................................................................. 61 

Solution 4-1: Creating Classic Reports ........................................................................................... 63 

Solution 4-2: Creating a Column Toggle Report ............................................................................. 86 

Solution 4-3: Adding and Modifying a List View Report .................................................................. 91 

Practices for Lesson 5: Working with Interactive Reports .......................................................... 97 

Practices for Lesson 5: Overview ................................................................................................... 98 

Practice 5-1: Creating and Manipulating an Interactive Report ...................................................... 99 

Practice 5-2: Customizing an Interactive Report ............................................................................ 101 

Solution 5-1: Creating and Manipulating an Interactive Report ...................................................... 103 

Solution 5-2: Customizing an Interactive Report ............................................................................ 139 

Practices for Lesson 6: Working with Interactive Grids ............................................................... 145 

Practices for Lesson 6 .................................................................................................................... 146 

Practice 6-1: Creating an Interactive Grid ....................................................................................... 147 

Practice 6-2: Using and Manipulating the Interactive Grid ............................................................. 149 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

iv  Oracle Application Express Workshop I – Table of Contents 

Solution 6-1: Creating an Interactive Grid ....................................................................................... 151 

Solution 6-2: Using and Manipulating the Interactive Grid ............................................................. 163 

Practices for Lesson 7: Working with Pages and Regions .......................................................... 169 

Practices for Lesson 7: Overview ................................................................................................... 170 

Practice 7-1: Creating and Modifying Pages and Regions ............................................................. 171 

Practice 7-2: Working with Global Pages ....................................................................................... 173 

Solution 7-1: Creating and Modifying Pages and Regions ............................................................. 175 

Solution 7-2: Working with Global Pages ....................................................................................... 197 

Practices for Lesson 8: Managing Forms ...................................................................................... 203 

Practices for Lesson 8: Overview ................................................................................................... 204 

Practice 8-1: Creating a Form ......................................................................................................... 205 

Practice 8-2: Creating a List View with Form .................................................................................. 207 

Practice 8-3: Creating a Master Detail Form (Side By Side) .......................................................... 210 

Practice 8-4: Creating a Master Detail Form (Stacked) .................................................................. 212 

Practice 8-5: Creating a Master Detail Form (Drill-Down) .............................................................. 214 

Solution 8-1: Creating a Form ......................................................................................................... 216 

Solution 8-2: Creating a List View with Form .................................................................................. 227 

Solution 8-3: Creating a Master Detail Form (Side by Side) ........................................................... 234 

Solution 8-4: Creating a Master Detail Form (Stacked) .................................................................. 246 

Solution 8-5: Creating a Master Detail Form (Drill Down) .............................................................. 252 

Practices for Lesson 9: Adding Items and Buttons ...................................................................... 259 

Practices for Lesson 9: Overview ................................................................................................... 260 

Practice 9-1: Adding Items and Buttons ......................................................................................... 261 

Practice 9-2: Manipulating Items .................................................................................................... 263 

Solution 9-1: Adding Items and Buttons ......................................................................................... 265 

Solution 9-2: Manipulating Items .................................................................................................... 289 

Practices for Lesson 10: Understanding Session State ............................................................... 319 

Practices for Lesson 10: Overview ................................................................................................. 320 

Practice 10-1: Understanding Session State .................................................................................. 321 

Solution 10-1: Understanding Session State .................................................................................. 323 

Practices for Lesson 11: Including Page Processing ................................................................... 339 

Practices for Lesson 11: Overview ................................................................................................. 340 

Practice 11-1: Creating and Manipulating Computations, Processes, and Validations.................. 341 

Solution 11-1: Creating and Manipulating Computations, Processes, and Validations.................. 343 

Practices for Lesson 12: Using Dynamic Actions and Plug-Ins .................................................. 379 

Practices for Lesson 12: Overview ................................................................................................. 380 

Practice 12-1: Using Dynamic Actions on Your Page .................................................................... 381 

Practice 12-2: Importing and Using Plug-Ins on Your Page ........................................................... 383 

Solution 12-1: Using Dynamic Actions on Your Page .................................................................... 384 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Oracle Application Express Workshop I – Table of Contents  v 

Solution 12-2: Importing and Using Plug-Ins on Your Page ........................................................... 417 

Practices for Lesson 13: Validating and Debugging Your Application ...................................... 433 

Practices for Lesson 13: Overview ................................................................................................. 434 

Practice 13-1: Using the Advisor..................................................................................................... 435 

Practice 13-2: Modifying the Attribute Dictionary ............................................................................ 436 

Solution 13-1: Using the Advisor .................................................................................................... 438 

Solution 13-2: Modifying the Attribute Dictionary ............................................................................ 445 

Practices for Lesson 14: Adding Shared Components That Aid Navigation ............................. 469 

Practices for Lesson 14: Overview ................................................................................................. 470 

Practice 14-1: Creating Lists and List Regions ............................................................................... 471 

Practice 14-2: Creating and Editing a Navigation Menu ................................................................. 473 

Practice 14-3: Adding Navigation Bar Entries ................................................................................. 475 

Practice 14-4: Adding Breadcrumbs to an Existing Page ............................................................... 477 

Solution 14-1: Creating Lists and List Regions ............................................................................... 480 

Solution 14-2: Creating and Editing a Navigation Menu ................................................................. 499 

Solution 14-3: Adding Navigation Bar Entries ................................................................................. 510 

Solution 14-4: Adding Breadcrumbs to an Existing Page ............................................................... 526 

Practices for Lesson 15: Working with Themes, Templates, and Files ...................................... 537 

Practices for Lesson 15: Overview ................................................................................................. 538 

Practice 15-1: Creating a Theme from Scratch .............................................................................. 539 

Practice 15-2: Copying, Editing, and Switching a Theme ............................................................... 541 

Practice 15-3: Editing Templates .................................................................................................... 543 

Practice 15-4: Uploading and Applying a CSS ............................................................................... 545 

Solution 15-1: Creating a Theme from Scratch .............................................................................. 547 

Solution 15-2: Copying, Editing, and Switching a Theme ............................................................... 550 

Solution 15-3: Editing Templates .................................................................................................... 560 

Solution 15-4: Uploading and Applying a CSS ............................................................................... 567 

Practices for Lesson 16: Implementing Security .......................................................................... 573 

Practices for Lesson 16: Overview ................................................................................................. 574 

Practice 16-1: Creating an Authentication Scheme ........................................................................ 575 

Practice 16-2: Restricting Users by Using Access Control ............................................................. 576 

Practice 16-3: Enabling Session State Protection .......................................................................... 578 

Solution 16-1: Creating an Authentication Scheme ........................................................................ 580 

Solution 16-2: Restricting Users by Using Access Control ............................................................. 587 

Solution 16-3: Enabling Session State Protection .......................................................................... 622 

Practices for Lesson 17: Managing Application Navigation ........................................................ 637 

Practices for Lesson 17: Overview ................................................................................................. 638 

Practice 17-1: Building a Hierarchical List with Images .................................................................. 639 

Practice 17-2: Building a Database-Driven Report ......................................................................... 642 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

vi  Oracle Application Express Workshop I – Table of Contents 

Practice 17-3: Building a Site Map .................................................................................................. 644 

Practice 17-4: Enforcing Authorization in Site Map ........................................................................ 647 

Solution 17-1: Building a Hierarchical List with Images .................................................................. 650 

Solution 17-2: Building a Database-Driven Report ......................................................................... 668 

Solution 17-3: Building a Site Map .................................................................................................. 679 

Solution 17-4: Enforcing Authorization in Site Map ........................................................................ 701 

Practices for Lesson 18: Extending Your Application ................................................................. 711 

Practices for Lesson 18: Overview ................................................................................................. 712 

Practice 18-1: Creating Data Load Wizard Pages .......................................................................... 713 

Practice 18-2: Adding an Upload and Download Page .................................................................. 716 

Solution 18-1: Creating Data Load Wizard Pages .......................................................................... 719 

Solution 18-2: Adding an Upload and Download Page .................................................................. 739 

Practices for Lesson 19: Creating and Editing Charts ................................................................. 759 

Practices for Lesson 19: Overview ................................................................................................. 760 

Practice 19-1: Creating and Modifying Charts ................................................................................ 761 

Practice 19-2: Creating Pie and Doughnut Charts.......................................................................... 764 

Practice 19-3: Creating Combination Chart .................................................................................... 766 

Solution 19-1: Creating and Modifying Bar Charts ......................................................................... 769 

Solution 19-2: Creating a Pie Chart and Converting it to a Doughnut Chart .................................. 778 

Solution 19-3: Creating Combination Chart .................................................................................... 786 

Practices for Lesson 20: Adding Calendars and Trees ................................................................ 803 

Practices for Lesson 20: Overview ................................................................................................. 804 

Practice 20-1: Creating a Calendar ................................................................................................ 805 

Practice 20-2: Creating a Tree ........................................................................................................ 807 

Solution 20-1: Creating a Calendar ................................................................................................ 810 

Solution 20-2: Creating a Tree ........................................................................................................ 822 

Practices for Lesson 21: Managing Application Feedback .......................................................... 833 

Practices for Lesson 21: Overview ................................................................................................. 834 

Practice 21-1: Adding and Monitoring Feedback in Your Application............................................. 835 

Solution 21-1: Adding and Monitoring Feedback in Your Application............................................. 838 

 

 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Oracle Application Express Workshop I – Table of Contents  vii 

Course Practice Environment: Security Credentials 

For OS usernames and passwords, see the following: 

 If you are attending a classroom-based or live virtual class, ask your instructor or 

LVC producer for OS credential information. 

 If you are using a self-study format, refer to the communication that you received 

from Oracle University for this course.  

 

For product-specific credentials used in this course, see the following table:  

 

Product-Specific Credentials 

Product/Application Username Password 

Workspace Administrator User apex_admin Initial login: apex 

Changed To: welcome 

(will be using this all 

through the course) 

Workspace Developer User apex_dev apex 

Workspace Developer User brad.knight apex 

Workspace Administrator User susie.parker apex 

Workspace End User john.bell apex 

Note: The credentials mentioned above are for the users of the APEX Workspace. The 

first user (that is, apex_admin) is already created. You will be creating all the other 

users during the practices. 
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Practices for Lesson 13: Overview 

Overview 

In these practices, you use the Oracle Application Express Advisor (Advisor) to validate your 

application; update the Attribute Dictionary based on items and report columns on your page; and 

examine how to use, debug, and resolve some common issues during application development. 
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Practice 13-1: Using the Advisor 

Overview 

In this practice, you use the Advisor to validate the GlobalMart Management Tool application. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Run the Advisor and correct an Accessibility warning on the 202 - Product Information page. 

2. Run the Advisor for the 202 - Product Information page. 

3. Run the Advisor again for the entire application. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 13-1. 

 

If you haven’t completed Practice 12-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_12_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 13-2: Modifying the Attribute Dictionary 

Overview 

In this practice, you update the Attribute Dictionary based on the items and report columns on your 

page. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Change the widths of items on the Customer Details page of the GlobalMart Management Tool 

application. 

2. Edit P9_ACCOUNT_MGR_ID. Change the item label and add help text. 

3. Add the items on the Customer Details page to the Attribute Dictionary. 

4. Review the UI defaults in SQL Workshop. Change the help text for CUST_FIRST_NAME to 

Customer First Name and add a Synonym called FIRST_NAME. 

5. Check whether CUSTOMERS is in Table Dictionary. 

6. Update the Attribute Dictionary for the items on the Customer Details page. 

7. Update the Customers page to use the Attribute Dictionary defaults. Verify by showing the help 

text for the First Name column in the report. 

8. Edit the Update Customers page to use the Attribute Dictionary defaults. Verify by showing the 

help text for the First Name column in the report. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 13-2. 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 13: Validating and Debugging Your Application  437 

If you haven’t completed Practice 13-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_13_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 13-1: Using the Advisor 

Overview 

In this practice solution, steps are provided for using the advisor to validate the GlobalMart 

Management Tool application. 

Steps 

1. Run the Advisor on the application and correct the warning on the 202 - Product Information 

page. 

a. From the Workspace home page, click App Builder and then select the GlobalMart 

Management Tool application. 

b. On the Application home page, click Utilities. 

 

c. On the Utilities page, click Advisor.  
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d. You can review the pages and checks to be performed by expanding Pages last edited 
with the last 7 days and Checks to Perform. For this exercise, accept the defaults. Click 
Perform Check. 
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e. The list of violations appears under Filter Result. Filter the results by deselecting  Error 
and Security and clicking Apply Filter. 

 

f. The Accessibility warning Message “Region has Row Header” appears. To address it, 
you will edit a report column and enable the Use As Row Header attribute. Click the View 
button. 

 

Note: Close the Advisor window, which is open in your browser. 
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g. The Product Information page opens in Page Designer view. On the Rendering tab (in the 
right pane), expand Regions > Content Body > Product Information > Columns and 

select PRODUCT_ID. 

 

h. In the Property Editor (left pane), under Settings > Use as Row Header, select Yes. 

 

i. Click Save. 
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2. Run the Advisor for the Product Information page. 

a. On the Page Designer toolbar, select the Utilities menu and then select Advisor. 
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b. Advisor automatically populates the Page(s) field. Click the Perform Check button. 

 

c. Note that violation has been resolved. Now only a Security, Authorization issue appears. 
You will be learning about authorizations in a later chapter.  

 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

444  Practices for Lesson 13: Validating and Debugging Your Application 

3. Run Advisor again for the entire application.  

a. In the Advisor window, expand the Check Page(s) region and delete the number in the 
Page(s) field. Click Perform Check again. 

 

b. Close the Advisor window. 

 

c. Return to the Application home page. Click the Application ID breadcrumb at the top of 
the page in the Page Designer view. 
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Solution 13-2: Modifying the Attribute Dictionary 

Overview 

In this practice solution, steps are provided for updating the Attribute Dictionary based on the items 

and report columns on your page. 

Steps 

1. Change the widths of items on the Customer Details page of the GlobalMart Management Tool 

application to the following:  

Item Attribute Value 

P9_CUST_FIRST_NAME Width 18 

P9_CUST_LAST_NAME Width 18 

P9_CUST_EMAIL Width 18 

a. On the GlobalMart Management Tool Application home page, select the Customer Details 
page. 
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b. Page Designer appears. On the Rendering tab, expand Regions > Content Body > 
Items.  

 

c. Under items, press and hold Ctrl + Shift and select P9_CUST_FIRST_NAME, 

P9_CUST_LAST_NAME, and P9_CUST_EMAIL.  
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d. In the Property Editor, under Appearance > Width, enter 18. 

 

e. Click Save. 
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2. Edit P9_ACCOUNT_MGR_ID. Change the item label and add help text.   

a. On the Rendering tab (left pane), under Regions > Content Body > Items, select 

P9_ACCOUNT_MGR_ID. 

 

b. By default, the Label Name appears as Account Manager in the Property Editor (right 

pane), under Label > Label. 
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c. Add Help Text. In the Property Editor, under Help > Help Text, enter Person assigned 

to account. 

 

d. Click Save and then Save and Run Page. 

 

e. The Customer Details page appears. Click the Question Mark icon  next to the 
Account Manger field. 

 

The Help Text window appears. 
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f. Click the Close icon. 

 

g. Click the Edit Page 9 link on the Runtime Developer toolbar. 
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3. Add the items on the Customer Details page to the Attribute Dictionary. 

a. Page 9 – Customer Details opens in Page Designer view. 

b. On the Page Designer toolbar, select the Utilities menu and then select Attribute 
Dictionary. 
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c. You need to review the items that you want to add to the Attribute Dictionary. Click the 
Review 6 items for insert into the Attribute Dictionary link. 

  

d. The items that you have on the page consist of all the changes that you made previously. 
Select the check box in the header to the left of the Region header to select all the entries 
in the list and click Update Attribute Dictionary. 

 

Note: The screenshot is truncated in size and is not the entire list. 

e. The message Attribute Dictionary Updated appears at the top of the page. 

 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 13: Validating and Debugging Your Application  453 

4. Review the UI defaults in SQL Workshop. Add Help Texts for CUST_FIRST_NAME and 

CUST_LAST_NAME. 

a. In the Tasks region on the right side of the page, click Access Attribute Dictionary. 

 

b. You see the attributes that you added to the dictionary. You can modify them here. Click 

CUST_FIRST_NAME. 
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c. Change Label to First Name, and in Help Text, enter Customer First Name. Click 

Apply Changes. 
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The changes appear on the Attribute Dictionary page.  

 

d. You also want to change the CUST_LAST_NAME. Click CUST_LAST_NAME. 
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e. Change Label to Last Name, and in Help Text, enter Customer Last Name. Click 

Apply Changes. 

 

The changes appear on the Attribute Dictionary page. 
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5. Check whether OEHR_CUSTOMERS is in the Table Dictionary. 

a. Click the Table Dictionary tab. 

 

b. Find OEHR_CUSTOMERS. Note that the Default Exists column displays No for this table, 

which means that user interface defaults are not configured and, therefore, do not exist in 
the Table Dictionary. 
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c. Select the App Builder > Database Application menu.  

 

d. On the App Builder home page, select the GlobalMart Management Tool application. 

 

 

6. To update the Attribute Dictionary for the items on the Customer Details: 

a. Click Utilities. 
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b. Click Attribute Dictionary. 

 

c. Click the link for the 9 - Customer Details page. 
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d. Notice that you have two items to review for update to the Attribute Dictionary. Click the 
Review 2 Items for update of the Attribute Dictionary link. 

 

e. Notice that the column in the Attribute Dictionary is the one that you want, rather than the 
help text for the item. You will leave it as is. 
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f. Click the Application ID breadcrumb to go back to the application. 

 

7. Update the Customers page to use the Attribute Dictionary defaults. Verify by showing the help 

text for the First Name and Last Name column in the report. 

a. Select 4 – Customers. 

 

b. Page: 4 Customers opens in Page Designer view. On the Page Designer toolbar, select 

Utilities  and Attribute Dictionary. 
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c. Because you want to update the page, you want to review the columns for update. Under 

Update Page, click the Review 5 Report Columns for update link. 

 

d. Review the list. Select the check box in front of CUST_FIRST_NAME item and click Update 

Report Column. 

 

You get the message Report Columns Updated. 
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e. Run the page to see the results. Click the Run Page 4 icon. 

 

f. To see the help text, select the First Name header in the report and click the Question 

Mark icon. 

 

The help text from the Attribute Dictionary appears.  
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g. Click the Application ID link on the Developer toolbar. 

 

 

8. Edit the Update Customers page to use the Attribute Dictionary defaults. Verify by showing the 

help text (that you entered in the Attribute Dictionary) for the First Name column in the report. 

a. Go to the GMT application home page and click 8 – Update Customer. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 13: Validating and Debugging Your Application  465 

b. Page 8: Update Customer opens in Page Designer view. On the Page Designer toolbar, 

select Utilities and Attribute Dictionary. 

 

c. Review the items to update. Under Update Page, click the Review 5 Items for update 

link. 
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d. Review the list. Select the check box next to the CUST_FIRST_NAME item. Click Update 

Items. 

 

 

You get the message Page Items Updated. 

 

e. Run the page to see the results. Click the Run Page 8 icon. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 13: Validating and Debugging Your Application  467 

f. To see the help text, select the First Name header in the report and click the Question 

Mark icon. The help text from the Attribute Dictionary appears.  

 

g. Click the Application ID link on the Developer toolbar to go back to your application. 
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Practices for Lesson 14: Overview 

Overview 

In this practice, you create a list and list region, create and edit navigation menu, add navigation 

bar entries, and add breadcrumbs to an existing page of the GMT application. 
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Practice 14-1: Creating Lists and List Regions 

Overview 

In this practice, you create a list of links that aid navigation. Using these links, a user will be able 

to navigate to the Customers, Products, and Orders pages. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice. 

Tasks 

1. In the GMT application, create a list called Home Page List with the following list entries: 

 View Customers (linked to the Customers page) 

 View Products (linked to the Products page) 

 View Orders (linked to the Orders page) 

2. Create a list region called Tasks in the Home region. 

3. Create a Dynamic List showing all the Products on the Products page. Create the List 

Region on the Products page by using the same Create List Wizard. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 14-1. 

 

If you haven’t completed Practice 13-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_13_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 
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f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 14-2: Creating and Editing a Navigation Menu 

Overview 

In this practice, you create a navigation menu for the application and assign pages to the menu. 

You also create a Help page and a Help tab to add to the existing tab set. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice.  

Tasks 

1. Create a navigation menu called Orders for the GMT application. It should be the current 

tab for the List of Orders page. Sequence the Orders entry before the Products navigation 

entry. 

2. Assign the Master Detail forms page to the Orders navigation entry. Run the application 

and confirm that the navigation is created successfully. 

3. Create a page called Help, and then add a new navigation menu entry called Help to the 

existing navigation menu. The new Help entry will link to the new Help page. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 14-2. 

 

If you haven’t completed Practice 14-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_14_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 
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f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 14-3: Adding Navigation Bar Entries 

Overview 

In this practice, you add a navigation bar entry that, when clicked, will show the page-level help. 

You also modify the name of an existing navigation bar entry and add another navigation bar 

entry that is displayed on all pages except the page that it navigates to. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice. 

Tasks 

1. Create a navigation bar entry called Help that navigates to the Help page. Run the page 

and click the Help navigation bar entry. 

2. Change the name of the navigation bar entry for Sign Out to Sign Off. 

3. Add a navigation bar entry called Home such that it appears between the Help and Sign 

Off button. Display the navigation bar entry on all pages except the Home page. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 14-3. 

 

If you haven’t completed Practice 14-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_14_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 
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f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 14-4: Adding Breadcrumbs to an Existing Page 

Overview 

In this practice, you create breadcrumbs and add it to the existing pages of the GMT application. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice. 

Tasks 

1. Edit the existing breadcrumb for the GMT application and create a breadcrumb entry for the 

Customers page. Run the customers page. Is the breadcrumb displayed on the page? 

2. Create a breadcrumb region on the Customers page and run the page. 

3. On the Customer Details page, create a breadcrumb called Customer Details whose 

parent entry is the Customers page. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 14-4. 

 

If you haven’t completed Practice 14-3, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_14_03.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 
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h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 
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i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 14-1: Creating Lists and List Regions 

Overview 

In this practice solution, steps are provided for creating lists and list regions for the GMT 

application. 

Steps 

1. In the GMT application, create a list called Home Page List with the following list entries: 

 View Customers (linked to the Customers page) 

 View Products (linked to the Products page) 

 View Orders (linked to the Orders page) 

a. On the GlobalMart Management Tool application home page, select Shared 
Components. 

 

b. In the Navigation section, click Lists. 

 

c. Click Create >. 
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d. Accept the default (that is From Scratch) and click Next >. 

 

e. For Name, enter Home Page List and click Next >. 
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f. Enter View Customers in the first List Entry Label field. Then click the 

corresponding up button and select the Customers page (Page 4) for Target Page ID 

or custom URL. Similarly, enter View Products and View Orders in the second 

and third List Entry Label fields. Then select the Products (Page 7) and List of Orders 

(Page 12) pages, respectively, by clicking the  icon. Click Next >. 

 

g. Accept the default and click Create List. 
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The Home Page List is created. 
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h. Click the Application 111 breadcrumb. 

 

 

2. Create a list region called Tasks in the Home region. 

a. On the GMT application home page, click 1 - Home. 
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b. On the Rendering tab, right-click Regions and select Create Region. 

 

c. On the Region tab, enter the following value for the respective fields: 

 Identification > Title: Enter Tasks 

 Identification > Type: Select List 

 Source > List: Select  Home Page List 

 

d. To view the list, run the page. Click the Save and Run Page icon. 
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e. The list is displayed. Click the View Products link. 

 

f. The Products page is displayed. Click the Edit Page 7 link on the Developer toolbar. 
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3. Create a Dynamic List showing all the Products on the Products page. Create the List 

Region on the Products page by using the same Create List Wizard. 

a. Page 7: Products open in Page Designer view. On the Products page, click the 
Shared Components icon. 

 

b. In the Navigation section, click Lists. 

c. Click Create >. 
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d. Accept the default and click Next >. 

 

e. Enter List of Products for Name and select Dynamic for Type. Click Next >. 
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f. Select Build Query. 
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g. In the Create Dynamic List window, select OEHR_PRODUCTS for Table or View. Click 

Next >. 
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h. Select PRODUCT_NAME(Nvarchar2) for Label Column and 

CATALOG_URL(Varchar2) for Target Column. Click Next >. 
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i. Click Finish. 

 

j. Click Next >. 
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k. Select Create list region on current page for Create List Regions? and Page 
Template Body (3) for Region Position. Click Create. 

 

l. The List of Products Dynamic list is created. Click the Run Page 7 icon. 
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m. Scroll to the bottom of the page. The list appears. You will now make the list collapsible 
and Collapsed by default. Click the Edit Page 7 link on the Developer toolbar.
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n. Select Regions > Body 3 > List of Products on the Rendering tab. 

 

o. In the Property Editor, select Appearance > Template > Collapsible. 
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p. Click the button in the Appearance > Template Options field. 

 

q. Change the Common > Default State to Collapsed and click OK. 
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Note: By default, the collapsible region is expanded. 

r. Click the Save and Run Page icon. 

 

s. Notice that the List of Products is now displayed in a collapsible region and the region 
is collapsed by default. Expand the List of Products region by clicking the arrow next  
to it. 

 

t. The list is now expanded. Click the Application 111 link on the Developer toolbar. 
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Solution 14-2: Creating and Editing a Navigation Menu 

Overview 

In this practice solution, steps are provided for creating and editing a navigation menu for the 

GMT application. 

Steps 

1. Create a navigation menu called Orders for the GMT application. It should be the current 

tab for the List of Orders page. Sequence the Orders entry before the Products navigation 

entry. 

a. Click the Shared Components icon. 

 

b. In the Navigation section, click Navigation Menu. 
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c. Click the Desktop Navigation Menu link. 

 

Click the Create Entry > link to add a new navigation entry. Note the Sequence 
number of the Products entry. 

 

d. Enter the following values for the respective fields: 

 Enter 25 for sequence. (Note: The sequence value should be between the 

Customers and Products sequence value.) 

 Enter Orders for List Entry Label. 

 Select Page in the Application for Target Type. 

 Select the List of Orders page number (Page 12) for Page. 

 Select Comma Delimited Page List for List Entry Current for Page Type. 

 Enter the List of Orders page number (Page 12) for List Entry Current for 
Condition. 
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e. Click the Create List Entry button. 

 

 

2. Assign the Master Detail page to the Orders navigation entry. Run the application and 

confirm that the navigation is created successfully. 

a. Click the Grid Edit button. 

 

b. Select Orders row and click the Edit button. Add the Master Detail form Oehr Orders 
page number for Orders (Page 13) in the Pages field of the Orders row. Delimit the 
page numbers by using a comma. 
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c. Click Save. 

 

You get the message “List changes saved”. 

 

d. Select the Application 111 breadcrumb and click Run Application.
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e. The application is displayed. Click the Orders tab. 

 

f. The List of Orders page is displayed. Click the Edit icon for the first entry. 
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g. The Master Detail form page Oehr Orders (13) is displayed. Notice that the Orders 
tab is still active. Click the Application 111 link on the Developer toolbar. 

 

 

3. Create a page called Help, and then add a new navigation menu entry called Help to the 

existing navigation menu. The new Help entry will link to the new Help page. 

a. You want to create a new page that will contain the help information. Click Create 
Page >. 
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b. Select Blank Page.  

 

c. For Page Number, enter 20. For Name, enter Help, and click Next >.  
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d. Select the Create a new navigation menu entry option for Navigation Preference. 

Ensure Help is selected for New Navigation Menu Entry and then click Next >. 
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e. Click Finish. 

 

f. Run the page to see the new navigation menu entry. Click the Save and Run Page 
icon. 
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g. The navigation menu entry is displayed. In the next practice, you add a region to the 
Help page and add it as a navigation bar entry. Click the Edit Page 20 link on the 
Developer toolbar. 
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Solution 14-3: Adding Navigation Bar Entries 

Overview 

In this practice solution, steps are provided for adding navigation bar entries to the GMT 

application. 

Steps 

1. Create a navigation bar entry called Help that navigates to the Help page. Run the page 

and click the Help navigation bar entry. 

a. Click the Shared Components icon. 

 

b. Under Navigation, click Navigation Bar List. 
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c. Click the Desktop Navigation Bar link. 

 

d. Click Create Entry >. 

 

e. Enter the following values for the respective fields: 

 Entry > List Entry Label: Enter Help 

 Target Type: Select Page in this Application 

 Target > Page: Select 20 

 Target > Request: Enter &APP_PAGE_ID. 

Note: By specifying the &APP_PAGE_ID. bind variable as the request, you are 

instructing the Oracle Application Express engine to display the Help text for the 

current page when the user clicks the navigation bar entry link.  

Click Create List Entry. 
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f. Click the Application 111 breadcrumb. 

 

g. Click Run Application. 
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h. Click the Help navigation bar entry. 

 

i. The Help page is displayed. You want to modify the Navigation Bar such that the Help 
button is displayed before apex_dev (&APP_USER.). Click the Edit Page 20 link on 
the Developer toolbar. 

 

 

j. Click the Shared Components icon. 
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k. Under Navigation, click Navigation Bar List. 

 

l. Click the List Details tab. 
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m. Notice the sequence value of &APP_USER., Sign Out, and the Help entries. Click the 
Grid Edit button. 
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n. Select the check box next to Help and click Edit.  

 

o. Change the Sequence of the Help entry to 5 and click Save.  

 

You get the message List changes saved. 
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p. Click the Run Page 20 icon. 

 

q. Notice that the Help button appears before the apex_dev (user) button in the 
Navigation Bar. You want to add a help text region on the Help page so that the help 
for the active page will be displayed. Click the Edit Page 20 link on the Developer 
toolbar. 
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r. Right-click Regions and select Create Region. 

 

s. In the Region panel, enter the following values for the respective fields: 

 Identification > Title: Enter Help 

 Identification > Type: Select Help Text 

t. Click the Save button. 

 

u. You need to enter some help text for a page. Enter the Customers page number 
(Page 4) in the Page Finder field and click Go. 
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v. In the Rendering panel, select the Customers page entry. 

 

w. On the Page tab, scroll down to the Help subtab. Enter This page provides 

information about Customers in the Help Text area and click the Save and Run 

Page icon. 

 

 

x. Click the Customers page and then select the Help Navigation Bar entry. 
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y. Notice that the Help text from the page definition is displayed. Click the Edit Page 20 
link on the Developer toolbar. 

 

 

z. Click the Shared Components icon. 

 

 

2. Change the name of the navigation bar entry for Sign Out to Sign Off. 

a. On the Navigation tab, click the Navigation Bar List link. 
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b. Click the Desktop Navigation Bar link. 

 

c. Click the Sign Out link. 
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d. Change the List Entry Label to Sign Off and click Apply Changes. 

 

 

3. Add a navigation bar entry called Home such that it appears between the Help and Sign 

Off button. Display the navigation bar entry on all pages except the Home page. 

a. Click Create Entry >. 

 

b. Enter the following values for the respective fields: 

 Entry > Sequence: Enter 7 

 Entry > List Entry Label: Enter Home 

 Target Type: Select Page in this Application 

 Target > Page: Select Home (Page 1) 
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 Conditions > Condition Type: Select Current page != Expression 1 

 Conditions > Expression 1: Enter 1 
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c. Click the Create List Entry button. 

 

d. Click the Run Page 20 icon. 

 

e. Note that the Home link is displayed at the top of the page. Click the Home tab. 

 

f. You see that the Home link is no longer displayed in the Navigation bar list. 
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g. Click the Customers tab. Notice that the Home navigation bar entry is displayed again.  

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

526  Practices for Lesson 14: Adding Shared Components that Aid Navigation 

Solution 14-4: Adding Breadcrumbs to an Existing Page 

Overview 

In this practice solution, steps are provided for creating breadcrumbs and adding them to the 

existing pages of the GMT application. 

Steps 

1. Edit the existing breadcrumb for the GMT application and create a breadcrumb entry for the 

Customers page. Run the customers page. Is the breadcrumb displayed on the page? 

a. You are currently on the Customers page. Notice that there is no Breadcrumb on this 
page. Click the Edit Page 4 link on the Developer toolbar. 

 

 

b. Click the Shared Components icon. 
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c. Under Navigation, click the Breadcrumbs link. 

 

d. Click the Breadcrumb icon. 

 

e. Click Create Breadcrumb Entry >. 
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f. Click the [4] quick pick for Page on the Breadcrumb tab. Select Home (Page 1) for 

Parent Entry and enter Customers for Short Name under Entry. Select 4 

(Customers) for Page under Target and click Create Breadcrumb Entry. 

 

 

g. Click the Run Page 4 icon. 
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h. Note that the breadcrumb you created is not reflected. This is because there is no 
breadcrumb region on this page. Click the Edit Page 4 link on the Developer toolbar. 

 

 

2. Create a breadcrumb region on the Customers page and run the page. 

a. In the Rendering panel, right-click Regions and select Create Region. 
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b. Ensure that the newly created Region is selected. On the Region tab, enter the 
following values for the respective fields: 

 Identification > Title: Enter Breadcrumb 

 Identification > Type: Select Breadcrumb 

 Source > Breadcrumb: Select Breadcrumb 

 Layout > Position: Select Breadcrumb Bar 

 

c. Click the Save and Run Page icon. 
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d. Note that now the breadcrumb is seen. Click the Edit icon next to any row in the report. 
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3. On the Customer Details page, create a breadcrumb called Customer Details whose 

parent entry is the Customers page. 

a. The Customer Details page does not have any breadcrumbs. You want to add one that 
has a parent entry to the Customers report on page 4. Click the Edit Page 9 link on the 
Developer toolbar. 

 

b. Right-click Regions and select Create Region. 
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c. Ensure that the newly created Region is selected. On the Region tab, enter the 
following values for the respective fields: 

 Identification > Title: Enter Breadcrumb 

 Identification > Type: Select Breadcrumb 

 Source > Breadcrumb: Select Breadcrumb 

 Layout > Position: Select Breadcrumb Bar 

 

d. Click the Save button. 
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e. You have created a breadcrumb region. Now you will create a breadcrumb. Click the 
Shared Components icon. 

 

f. Under Navigation, click Breadcrumbs. 

 

g. Click the Breadcrumb icon. 
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h. Click Create Breadcrumb Entry >. 

 

i. Click the [9] quick pick for Page on the Breadcrumb tab. Select Customers (Page 4) 

for Parent Entry and enter Customer Details for Short Name under Entry. Select 

9 (Customer Details) for Page under Target and click Create Breadcrumb Entry. 
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j. The Breadcrumb entry is created. Click the Run Page 9 icon. 

 

k. Notice that the breadcrumb is now displayed. Click the Application 111 link on the 
Developer toolbar. 
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Practices for Lesson 15: Overview 

Overview 

In these practices, you create a theme from scratch; copy, edit, and switch a theme; edit the 

theme templates; and upload and apply a CSS in the GlobalMart Management Tool application. 
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Practice 15-1: Creating a Theme from Scratch 

Overview 

In this practice, you create a theme from scratch for the GlobalMart Management Tool 

application. 

Assumptions 

You have completed the previous practices. 

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice. 

Tasks 

1. Create a new theme from scratch. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 15-1. 

 

If you haven’t completed Practice 14-4, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_14_04.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 

i. Click Install. 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

540  Practices for Lesson 15: Working with Themes, Templates, and Files 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 15-2: Copying, Editing, and Switching a Theme 

Overview 

In this practice, you copy an existing Universal Theme and then edit the theme. You will later 

switch the current theme to reflect the newly modified theme. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice. 

Tasks 

1. Copy an existing theme and then edit it.  

2. Switch the theme of your application to the newly created theme. What do you observe? 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 15-2. 

 

If you haven’t completed Practice 15-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_15_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 
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i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 15-3: Editing Templates 

Overview 

In this practice, you customize the template according to the requirements of the GlobalMart 

Management Tool. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the catch 

up section of this practice. 

Tasks 

1. Upload the logo.png image from your /home/oracle/labs/labs/ directory and add 

it as a logo for your application. 

2. On your Home page (Page 1), change the Tasks list to appear on the right side of the page, 

vertically. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 15-3. 

 

If you haven’t completed Practice 15-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_15_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 
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h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 15-4: Uploading and Applying a CSS 

Overview 

In this practice, you upload a CSS file and apply it to the pages of the GMT application to 

enhance its look and feel. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the 

Catch Up section of this practice. 

Tasks 

1. Upload the apexstyle.css file from the /home/oracle/labs/labs/ directory. 

2. Add the cascading style sheet to the Help region on the Help page. 

3. Change the Help text to use the new style, bigblue, by using the following script (located in 

/home/oracle/labs/labs/lab_15_04.txt): 

<span class=”bigblue”>No help is available for this page.</span> 

 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the 

/home/oracle/labs/solutions directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to 

install a sample dataset before you start with Practice 15-4. 

 

If you haven’t completed Practice 15-3, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_15_03.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 
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f. Select Reuse Application ID 111 From Export File for the Install As Application 
option and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click 
Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 15-1: Creating a Theme from Scratch 

Overview 

In this practice solution, steps are provided for creating a theme from the beginning for the 

GlobalMart Management Tool application. 

Steps 

1. Create a new theme by using the Theme repository. 

a. On the GlobalMart Management Tool application home page, click Shared 
Components. 

 

b. Under User Interface, click Themes. 
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c. Notice that there is one existing theme currently in the list. To create a new theme, 
click the Create > button. 

 

 

d. Ensure that the From Scratch method is selected and click Next >. 

 

e. Enter the following values and click Create:  

 Theme Number: Enter 101. 

 Name: Enter My New Theme. 

 Identifier: Enter BLUE_101. (The identifier is an arbitrary number and must be 

unique within your application.) 
 Navigation Type: Select List. 
 Navigation Bar Implementation: Select List. 
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 Description: Enter This is a new theme created from scratch. 

 

The new theme is created. 
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Solution 15-2: Copying, Editing, and Switching a Theme 

Overview 

In this practice solution, steps are provided for copying an existing theme and then modifying it 

according to the requirements of the GlobalMart Management Tool application. Later, steps are 

provided to switch the current theme. 

Steps 

 

1. Copy an existing theme and then edit it. 

a. To copy an existing theme, go to the Themes page. Select Copy Theme on the right.  
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b. Enter 102 for Copy to this Theme ID. Click Next >. 

  

c. The Confirm page appears. Evaluate the Application (Name/ID), Copy Theme From ID, 
and Copy Theme ID to options and click Copy Theme. 
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d. You can see the copied theme listed on the Themes page. 
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2. Edit and modify the theme that you just copied from the Universal Theme – 42.  

a. On the Themes page, click Universal Theme – 102. 
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b. The Create/Edit Theme page appears. You can make the necessary changes you want 

for your Theme on this page.  
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c. Click the Component Defaults tab. Change Page from Standard to Marquee. 

 

d. Click Apply Changes. 
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3. Switch the theme of your application to the newly copied and edited theme. What do you 

observe? 

a. To use the theme that you just created in your application, you must switch to that 
theme. Click Switch Theme. 

 

b. Select Currently Active Theme from the drop-down list, in this case, 42. Universal 
Theme. Make sure 102. Universal Theme is selected for Switch to Theme and click  
Next >. 
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c. The Verify compatibility page appears. The Status columns display the check marks. 
Click Next >.  

 

 

d. Click Switch Theme. 

 

You get the message Active Theme Switched. 
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Click Application 111 breadcrumb and then run the application.  
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You will see that all the pages have changed from the Standard page to Marquee 
(Expand / Collapse Side Column). This is because you have changed the current 
theme from Universal Theme – 42 to the newly edited theme Universal Theme – 102. 
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Solution 15-3: Editing Templates 

Overview 

In this practice solution, steps are provided for customizing the template according to the 

requirements of the GlobalMart Management Tool. 

Steps 

1. Upload the logo.png image from your /home/oracle/labs/labs/ directory and add 

it as a logo for your application. 

a. Click Shared Components. 

 

b. Under Files, click the Static Application Files link. 

 

c. Click Upload File >. 
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d. Select the logo.png file in your /home/oracle/labs/labs/ folder for File and 

click Upload. 

 

e. Notice that the file is uploaded. Copy the reference of the file. 
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f. You will now add the logo to your application. Click the Shared Components 
breadcrumb. 

 

g. Under User Interface, click the User Interface Attributes link. 

 

h. Make sure that the User Interface subtab is selected and click Logo. 

 

i. Select the Logo Type as Image and enter the reference that you copied for Logo. 
Click Apply Changes. 

#APP_IMAGES#logo.png 
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j. Run the page. Click the Run Application icon. 

 

k. Note that all your pages display the logo. Make sure that you are on the Home page 
and click the Edit Page 1 link on the Developer toolbar. 

 

 

2. On your Home page (Page 1), change the Tasks list to appear on the right side of the 

page, vertically. 
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a. You want to modify the Tasks region. Before modifying that, you need to change the 
page property. On the Rendering tab, select Page 1: Home. 

 

b. On the Page tab, select Right Side Column for Appearance > Page Template. 
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c. In the Layout, drag the Tasks region to inside the right column/right side column area. 
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d. Click the Save and Run Page icon. 

 

e. The Tasks region is in place. Click the Edit Page 1 link on the Developer toolbar. 
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Solution 15-4: Uploading and Applying a CSS 

Overview 

In this practice solution, steps are provided for uploading the CSS file and applying it to the 

pages of the GMT application to enhance its look and feel. 

Steps 

1. Upload the apexstyle.css file from the /home/oracle/labs/labs/ directory. 

a. Click the Shared Components icon. 

 

b. Under Files, click the Static Application Files link. 

 

c. Click Upload File >.  
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d. Select the apexstyle.css file in your /home/oracle/labs/labs/ folder for File and 

click Upload. Note that if you view the CSS file, you will notice that the name of the 

style is bigblue. 

 

e. Notice that the file is uploaded. Copy the reference of the file. 
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f. Click the Edit Page icon on the top right corner. 

 

 

2. Add the cascading style sheet to the Help region on the Help page. 

a. Navigate to the Help page. Enter the page number of the help page (Page 20) in the 

Page Finder field and click Go. 

 

b. You first need to add the style sheet to the Help page. On the Rendering tab, ensure 
that Page 20: Help is selected. 
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c. In the CSS > File URLs field, enter the reference to the uploaded file. 

#APP_IMAGES#apexstyle.css 

 

 

3. Change the Help text to use the new style, bigblue, by using the following script (located in 

/home/oracle/labs/labs/lab_15_04.txt): 

<span class=”bigblue”>No help is available for this page.</span> 

a. On the Page tab, enter the following for the Help Text field (located in 

/home/oracle/labs/labs/lab_15_04.txt): 

<span class=”bigblue”>No help is available for this page.</span> 
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Note: Do not copy the script from this document. Copy the script from the TXT file only. 

b. Click the Save and Run Page icon. 

 

c. The style sheet is successfully applied to the Help page. Click the Application 111 link 
on the Developer toolbar. 
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Practices for Lesson 16: Overview 

Overview 

In these practices, you examine how to implement security within your application. 
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Practice 16-1: Creating an Authentication Scheme 

Overview 

In this practice, you create an authentication scheme and then make it the current default. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create an authentication scheme called OpenDoor based on the Open Door credentials. 

2. Switch the current authentication scheme to Application Express. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 16-1. 

 

If you haven’t completed Practice 15-4, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_15_04.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >.  

i. Click Install.  

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 16-2: Restricting Users by Using Access Control 

Overview 

In this practice, you create an access control page, set the application mode to restrict access, 

create the access control list, and assign application components to an authorization scheme. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create the following users to add to the access control list. 

Name User Type 

brad.knight Developer 

susie.parker Workspace Administrator 

john.bell End User 

2. Create an access control page for the GMT application.  

3. Set the access control mode to No to give restricted access to only users defined in the access 

control list to use the application. 

4. Add users to the access control list: 

 john.bell can only view the information in the application; he cannot make any changes 

to application data. 

 brad.knight should be allowed to edit application data, but he cannot change 

application administration settings (application mode and the access control list). 

 susie.parker is the administrator of the application, so she can change anything in 

addition to changing user privileges. 

 apex is also an administrator of the application. 

5. Define and apply the authorization schemes to each application component. This will restrict 

access to application pages and components. 

 Users with the Reader privilege can review customer information, but cannot change or 
create information. 

 Users with the Contributor privilege can make changes to customer information but 
cannot make changes to the application mode and the access control list. 

 Users with the Administrator privilege can make any changes, including administering the 
GMT application. 

6. Run the application and sign in as a different user. What do you observe? 
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Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 16-2. 

 

If you haven’t completed Practice 16-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >.  

i. Click Install.  

j. Verify that the application and the supporting objects are successfully installed.  
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Practice 16-3: Enabling Session State Protection 

Overview 

In this practice, you enable Session State Protection, set the Session State Protection for a 

particular item, and review the various options for page access protection so that you can examine 

their differences. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Set the Page Access Protection for the Employee Commission page to No URL Access. 

2. Add a Commission button to the Top Tier Salary page that redirects to the Employee 

Commission page. Run the page to see that there is an error because of the branch. 

3. Edit the Commission button to submit the page and create a Branch to Page branch that will 

go to the Employee Commission page without passing the URL. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

a. Click the arrow next to SQL Workshop and select SQL Scripts. 

b. Click the Upload > button. 

c. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

d. Run the script by clicking the Run icon. 

e. Click Run Now. 

f. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 16-3. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 
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g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Log out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now. 

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click the Roles and User Role Assignments tab, you see that the above 
users are created with their respective roles.  
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Solution 16-1: Creating an Authentication Scheme 

Overview 

In this practice solution, steps are provided for creating an authentication scheme for GlobalMart 

Management Tool. 

Steps 

1. Create an authentication scheme called OpenDoor based on the Open Door credentials. 

a. On the application home page, click Shared Components. 

 

b. Under Security, click the Authentication Schemes link. 
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c. You will see that Application Express Authentication is set as the Current Authentication 
scheme. Click Create >. 

 

 

d. Leave the default value of Based on a pre-configured scheme from the gallery and 
click Next >. 

 

e. For Name, enter OpenDoor and select the Open Door Credentials option for the Scheme 

Type. Click Create Authentication Scheme. 

 

The OpenDoor Authentication scheme is created, and it becomes the Current 

Authentication scheme. 
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f. Click Application 111 breadcrumb and click Run Application.  

 

g. To sign into the system, enter your name in the Username field and then click Login. 
Notice that the Sign in page uses the Open Door Credential Authentication scheme and 
does not prompt you to enter the password. If you are already logged in, click Sign Off and 
perform this step. 
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h. The Home page is displayed. In the next practice, you will use access control to set up 
authorization to certain pages and buttons. Click the Application 111 link on the 
Developer toolbar. 

 

 

2. Switch the current authentication scheme to Application Express. 

a. Navigate to the Shared Components page. Click the Shared Components icon. 
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b. Under Security, select Authentication Schemes. 

 

c. Click the Application Express Authentication link. 
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d. Click Make Current Scheme. 

 

e. You get the following message. Click OK. 

 

Application Express Authentication is now the current scheme. 
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f. Click the Run Page 1 icon. 

  

g. Click Sign Off. 

 

h. Notice that the Sign in page uses the Application Express authentication login now instead 
of the OpenDoor login. Click the Application 111 link on the Developer toolbar. 
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Solution 16-2: Restricting Users by Using Access Control 

Overview 

In this practice solution, steps are provided for restricting users to access GlobalMart Management 

Tool by using Access Control. 

Steps 

1. Create the following users to add to the access control list: 

Name User Type 

brad.knight Developer 

susie.parker Workspace Administrator 

john.bell End User 

a. Sign out of Application Express. Click the Account Menu icon at the top-right section of 
the page and click Sign out. 
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b. Click the Return to Sign In Page button. 

 

c. Sign in as the apex_admin user (workspace administrator).  
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d. Click the Administration icon and select Manage Users and Groups. 

 

e. Click Create User >. 

 

f. Enter the following information and click Create and Create Another: 

 Username: brad.knight 

 Email Address: brad.knight@oracle.com 

 Default Schema: OEHR 

 Select No for the User is a workspace administrator option. 

 Select Yes for the User is a developer option. 

 Password: <refer the password document> 

 Confirm Password: <refer the password document> 

 Select No for Require Change of Password on First Use. 
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In the Group Assignments section, click >> to assign the OAuth2 Client Developer, 

RESTful Services, and SQL Developer roles to the user. 
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g. Enter the following information and click Create and Create Another: 

 Username: susie.parker 

 Email Address: susie.parker@oracle.com 

 Default Schema: OEHR 

 Select Yes for the User is a workspace administrator option. 

 Password: <refer the password document> 

 Confirm Password: <refer the password document> 

 Select No for Require Change of Password on First Use. 
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 In the Group Assignments section, click >> to assign the OAuth2 Client Developer, 

RESTful Services, and SQL Developer roles to the user. 
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h. Enter the following information and click Create User: 

 Username: john.bell 

 Email Address: john.bell@oracle.com 

 Default Schema: OEHR 

 Select No for the User is a workspace administrator option. 

 Select No for the User is a developer option. 

 Password: <refer the passwords document> 

 Confirm Password: <refer the passwords document> 

 Select No for Require Change of Password on First Use. 

 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

594  Practices for Lesson 16: Implementing Security 

 In the Group Assignments section, click >> to assign the OAuth2 Client Developer, 

RESTful Services, and SQL Developer roles to the user. 

 

 

The new users are now in the list. 
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i. Click the View Icons button. 
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2. Create an access control page for the GMT application. 

a. Select App Builder > Database Applications.  

  

b. Open 111 GlobalMart Management Tool application. 

 

c. Ensure that you are signed in as an Administrator (username: apex_admin) and click 
Create Page >. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 16: Implementing Security  597 

d. Click the Feature tab and select Access Control. 

 

e. On the Create Access Control page, enter the following values and click Next: 

 Starting Page Number: Enter 10010. 

 Administration Page Reference: Select Create a new page. 

 Administration Page Number: Enter 10000. 

 Administration page Name: Enter Access Control Administration Page. 

 Administration Page Navigation Preference: Select Create a new navigation menu 

entry. 

 New Navigation Menu Entry Name: Enter Admin. 

 Parent Navigation Menu Entry Select: -No parent selected - 
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f. The Create Access Control Pages - Confirmation page appears. Review the details and 
click Create.  
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g. The Page 10000: Access Control Administration Page opens in Page Designer view. 
Click the Save and Run Page icon. 

 

 

h. Sign in as the apex_admin user (workspace administrator). 
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The Access Control Administration Page with links to Users and Access Control loads 

with the message “Only users defined in the application access control list may access this 

application.” 
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3. Set Access Control for access to the authenticated users.  

a. Click the Access Control link. 

 

b. The Configure Access Control page appears. You want to give restricted privileges to only 

the users defined in the access control list. Select No. Click Apply Changes.  

 

The message “Access Control settings saved” appears. 
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4. Add users to the access control list: 

 john.bell can only view the information in the application; he cannot make any changes 

to application data. 

 brad.knight should be allowed to edit application data, but he cannot change 

application administration settings (application mode and the access control list). 

 susie.parker is the administrator of the application, so she can change anything in 

addition to changing the user privileges. 

 apex_dev user is already created, but you must grant apex_dev user to the access 

control list. 

[apex_admin is already existing as an administrator of the application.] 

a. The access control mode has been set. Now, users whose credentials are defined in the 
access control list can access your GlobalMart Management Tool application. To add your 
privileged users, click Add User. 

 

Note that alternatively, you can add a user by clicking the User link and then clicking Add 

User. 
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b. You want John Bell to only be able to view the information in your application. He cannot 

make any changes to application data. Enter john.bell as Username and select 

Reader for Role. Then click Add User. 
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c. You want Brad Knight to be able to edit the information in your application, but not be able 

to change any of the administration options. Enter brad.knight as Username and 

select Contributor for Role. Then click Add User. 

 

d. You want Susie Parker to be able to edit the information in your application as well as 

update the administration access control list. Enter susie.parker as Username and 

select Administrator for Role. Click Add User. 
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e. You want apex_dev user (that you had created in the initial practices) to be able to edit the 
information in your application, but not be able to change any of the administration options. 

Enter apex_dev as Username and select Contributor for Role. Then click Add User. 

  

The following users with their respective roles/privileges are created: 
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5. Define and apply the authorization schemes to each application component. This will restrict 

access to application pages and components. 

 Users with the Reader privilege can review customer information, but cannot change or 
create information. 

 Users with the Contributor privilege can make changes to customer information but 
cannot make changes to the access control mode and the access control list. 

 Users with the Administrator privilege can make any changes, including administering the 
GMT application. 

a. You can define which areas of the application are restricted. Click the Application 111 link 
on the Developer toolbar. 

 

b. You can restrict access for users with the view privilege to customer information. On the 
GlobalMart Management Tool application home page, click 4- Customers page. 
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c. On the Rendering tab, select Regions > Content Body > Customer Report > Attributes. 
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d. In the Property Editor, select Contribution Rights for Authorization Scheme under Link. 
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e. You want the Create Button to appear only if the user has the Contributor or 
Administrator privilege. To achieve this, you must set the authorization scheme 
accordingly. Under Buttons for the Customer Report region, select CREATE. 
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f. On the Button tab, scroll down to the Security tab. Select Contribution Rights for 
Authorization Scheme and click Save. 

 

g. You also want to protect against direct access to a page. Even though you restricted a user 
who did not have the Contributor privilege from editing or creating users on the Customers 
page, he or she can still access Customer Details if the correct URL is entered. To prevent 
this from happening, you must restrict Customer Details to only users with the Contributor 
(Edit) privilege. In Page Finder, enter the page number of the Customer Details page (in 

this case 9) and click Go. 
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h. On the Rendering tab, select Page 9: Customer Details. 

 

i. On the Page tab, select Contribution Rights for Authorization Scheme under Security. 
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j. Click the Save button. 

 

k. Click the Application 111 breadcrumb to return to the GlobalMart Management Tool 
application home page. 

 

l. Enter admin in the search area and click Go. 
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m. Because users with the Administrator privilege are only allowed to make changes to the 
access control list, you must review the authorization scheme for the Access Control 
Administration page. Click Access Control Administration Page. 

 

n. On the Rendering tab, select Page 10000: Access Control Administration Page. 
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o. On the Page tab, you see that Administration Rights is already selected by default for the 
Authorization Scheme under Security and click Save. 

  

 

6. Run the application and sign in as a different user. What do you observe? 

a. Now you are ready to run the application. In the Page Finder field, enter 1 for Page and 

click Go. 

 

b. Click the Save and Run Page icon. 

 

c. If you are already logged in, click Sign Off. 
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d. Enter login credentials of brad.knight and click Sign in. 

 

e. On the Tasks tab, click View Customers. 

 

  O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 16: Implementing Security  617 

f. Notice that Brad can edit customer information and can see the Create button. Click the 
Admin tab. 

 

g. You receive an error because you need the Administrator privilege to access this page. 
Click OK. 

 

h. Click Sign Off. 
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i. Enter the login credentials of john.bell and click Sign in. 

 

j. Click View Customers. 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 16: Implementing Security  619 

k. John has the Reader privilege only and, therefore, cannot edit customer information. Also, 
the Create button is not displayed for him. 

 

l. Change the page number in your URL to try to access the Customer Details page. Press 
the Enter key: 

Example url .../f?p=111:4:8958804941859::::: 

Change to .../f?p=111:9:8958804941859::::: 
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m. Notice the change of page number in the URL. You receive a message denying access to 
the page, because access to the Customer Details page is restricted to users with the 
Contributor privilege and John Bell has only the Reader privilege assigned to him. Click 
OK. 

 

 

n. Lastly, you want to sign in as Susie Parker, who is an administrator. Click Sign Off. 
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o. Enter the login credentials of susie.parker and click Sign in. 

 

p. Click the Admin tab. 

 

q. Notice that because Susie is an Administrator, you can access this page. Click the 
Application 111 link on the Developer toolbar. 
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Solution 16-3: Enabling Session State Protection 

Overview 

In this practice solution, steps are provided for enabling Session State Protection in GlobalMart 

Management Tool. 

Steps 

1. Set the Page Access Protection for the Employee Commission page to No URL Access. 

a. Sign in as Click Shared Components. 

 

b. Under Security, select Session State Protection. 
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c. Click the right arrow (>) next to Pages. 

 

d. Click the Page link for the Employee Commission page. 

 

  
O

ra
cl

e 
In

te
rn

al
 &

 O
ra

cl
e 

Ac
ad

em
y 

U
se

 O
nl

y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

624  Practices for Lesson 16: Implementing Security 

e. Select No URL Access for Page Access Protection and click Apply Changes. 

 

You get the message Action Processed. 

 

 

2. Add a Commission button to the Top Tier Salary page that redirects to the Employee 

Commission page. Run the page to see that there is an error because of the branch. 

a. Click the Application 111 breadcrumb.  

 

b. Click the Top Tier Salary page. 
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c. On the Rendering tab, right-click Report 1 and select Create Button. 

 

d. On the Rendering tab, make sure that the newly created button is selected. On the Button 
tab, enter the following values for the respective fields: 

 Identification > Button Name: Enter Commission 

 Identification > Label: Commission (This value will be automatically populated.) 

 Layout > Button Position: Select Top of Region 

 Appearance > Hot: Select Yes 

 Behavior > Action: Select Redirect to Page in this Application 

 Behavior > Target > Page: Select  5 (Page number of the Employee Commission 

page) and click OK. 
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e. Click the Save and Run Page icon. 

 

f. Click Commission. 
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g. Notice you receive an error indicating that you must create a Branch to the Page branch 
that generates a page without a URL. Click OK. 
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3. Edit the Commission button to submit the page and create a Branch to Page branch that will 

go to the Employee Commission page without passing the URL. 

a. Click the Edit Page 2 link on the Developer toolbar. 

 

b. On the Rendering tab, make sure that the Commission button is selected. On the Button 
tab, select Submit Page for Behavior > Action. 
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c. Now you need to create a Branch to Page branch. In Page Designer, click the 
Processing tab. 
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d. Right-click After Processing and select Create Branch. 

 

e. On the Branch tab, enter the following values for the respective fields: 

 Identification > Name: Enter Go to Page 5 

 Execution Options > Point: Select After Processing (by default) 

 Behavior > Type: Select Page (Show only) 

 Behavior > Page Number: Select 5 (Page number of the Employee Commission 

page) 

 Condition > When Button Pressed: Select Commission 
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f. If you save and run the page and click the Commission button now, you will get the 
following error as the Reload on Submit under Advanced is currently set as Only for 
Success for Page 2: Top Tier Page: 

 

To change it:  

i. Click Edit Page 2 on the Developer toolbar. 
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ii. Page 2: Top Tier Salary opens in Page Designer view. Select Page 2: Top 
Tier Salary in the Rendering pane and select Always for Reload on 
Submit under Advanced.  
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iii. Click the Save and Run Page icon. 

 

g. Click Commission. 
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h. The Employee Commission page is displayed. Review the URL. Notice that it no longer 

passes the f?p= in the URL, and it is rendered successfully. Click the Application 111 link 

on the Developer toolbar. 
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Practices for Lesson 17: Overview 

Practices Overview 

In these practices, you build a hierarchical list with images, a database-driven report, and a site map 

and enforce authorization on the site map. 
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Practice 17-1: Building a Hierarchical List with Images 

Overview 

In this practice, you upload the images to the Home Page List that you have created in the previous 

practices, assign the pull-down menu with the images template to the list, change the attributes of 

the Tasks region, and associate the region with each Parent List Entry. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Change the Home Page List to the following list structure and add icons for each parent entry: 

Sequence List Entry Label Parent List Entry Page Number 

10 Manage Customers   

12 View Customers Manage Customers 4 

20 Manage Products   

22 View Products Manage Products 7 

30 Manage Orders   

32 View Orders Manage Orders 12 

2. In the Home page, change the region template of Tasks to no template, the List Template to 

Navigation Bar, and the Page Template to Theme Default. 

3. Run the page to see the Home Page List. Click the parent entry to show the sublist entries. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 17-1. 
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If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. From the application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles 
are imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application 
ID. Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now. 

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles.  

 

If you haven’t completed Practice 16-3, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_03.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 
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h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >.  

i. Click Install.  

j. Verify that the application and the supporting objects are successfully installed.  
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Practice 17-2: Building a Database-Driven Report 

Overview 

In this practice, you build a report based on the data in a table and then navigate to the detail. You 

also change the template to the Navigation Region template. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create a new page with a Classic Report called List of Customers. 

2. Hide the CUSTOMER_ID column in the report and turn off pagination. Display the Customer 

Name column heading in blue by editing the column definition and entering the following for 

Column Heading. 

<font color=”blue”>CUSTOMERS</font> 

3. Create a link to the Customer Details page on the NAME column. Pass the P9_CUSTOMER_ID 

item from the Customer Details page with the value #CUSTOMER_ID# from this page. 

4. Run the page to see the database-driven report. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 17-2. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 
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e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. From the application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles 
are imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application 
ID. Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now. 

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles.  

 

If you haven’t completed Practice 17-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_17_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >.  

i. Click Install.  

j. Verify that the application and the supporting objects are successfully installed.  
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Practice 17-3: Building a Site Map 

Overview 

In this practice, you build a site map page that is added as a navigation bar entry. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Assign each page that you want in the site map to the same page group. Create a page group 

called Site Map and assign the following pages to the Site Map page group. 

Pages 

Customers 

List of Orders 

Products 

Customer Feedback 

Access Control Administration Page 

2. Create a new page called Site Map with a Classic Report that shows only the pages in the Site 

Map page group. 

3. Change the Pagination Scheme to None and do not show the PAGE_ID column. Link the 

PAGE_NAME column to the #PAGE_ID# so that it opens the corresponding page when clicked. 

4. Add this page to your navigation bar and call it Site Map. 

5. Run the page and click one of the page names to view the corresponding page. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 17-3. 
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If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. From the application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles 
were imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application 
ID. Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now. 

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles.  

 

If you haven’t completed Practice 17-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_17_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

646  Practices for Lesson 17: Managing Application Navigation 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 17-4: Enforcing Authorization in Site Map 

Overview 

In this practice, you add a function that determines whether you are authorized to see a particular 

page in your Site Map. You also change the SQL Report query for the Site Map to make sure that 

the page is selected only if you are authorized to see it. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Navigate to SQL Workshop > SQL Commands. Copy and paste the following code (located in 

the /home/oracle/labs/labs/lab_17_04_01.txt file) to create the 

authorization_check function. 

create or replace function authorization_check( 

p_scheme in varchar2) 

return varchar2 

is 

begin 

if apex_util.public_check_authorization(p_scheme) then 

return 'true'; 

else 

return 'false'; 

end if; 

end; 

2. For the Site Map, change the Source for your Classic Report to the following code (also located 

in the /home/oracle/labs/labs/lab_17_04_02.txt file) so that only the pages that 

are authorized will be shown based on the user logged in. 

select distinct PAGE_ID, PAGE_NAME 

from APEX_APPLICATION_PAGES p, apex_application_authorization a 

where p.APPLICATION_ID = :APP_ID 

and a.application_id = p.application_id 

and (p.authorization_scheme is null or 

(a.authorization_scheme_id = p.authorization_scheme_id and 

authorization_check(a.authorization_scheme_name) = 'true')) 

and PAGE_GROUP = 'Site Map' 

3. You do not want end users or developers to see the Access Control Administration page. Make 

sure that the Authorization Schemes for this page is set to access control - Administrator. 

Run the page to see if only an authorized user can view it. 
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Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 17-4. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. From the application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles 
are imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application 
ID. Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  
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v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles.  

 

 

If you haven’t completed Practice 17-3, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_17_03.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 17-1: Building a Hierarchical List with Images 

Overview 

In this practice solution, steps are provided for building a hierarchical list with images. 

Steps 

1. Change the Home Page List to the following list structure and add icons for each parent entry: 

Sequence List Entry Label Parent List Entry Page Number 

10 Manage Customers   

12 View Customers Manage Customers 4 

20 Manage Products   

22 View Products Manage Products 7 

30 Manage Orders   

32 View Orders Manage Orders 12 

a. Sign out and sign in as the apex_dev user (workspace developer). 

b. Click the Shared Components icon. 

 

c. Under Navigation, select Lists. 
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d. Select Home Page List. 
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e. Click View Customers to edit this List Entry detail. 

 

f. In the Entry section, retain 10 for Sequence; change View Customers to Manage 

Customers for List Entry Label. In the Target section, change the Target type to - No 

Target -. In the Entry section, click the up arrow for the Image/Class field. 
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g. Make sure that Font APEX Icons is selected in the Show drop-down list. 

 

h. Select fa-user from the list. 
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i. Click Apply Changes. 

 

j. Click Create Entry >. 
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k. Select Manage Customers for Parent List Entry, enter 12 for Sequence, and enter View 

Customers for List Entry Label. In the Target section, make sure that Target type is set 

to Page in this Application and the Page is 4 (the page number corresponding to the 

Customer page). Then click Create List Entry. 
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l. Select View Products. 

 

m. In the Entry section, retain 20 for Sequence and enter Manage Products for List Entry 

Label. In the Target section, set the Target type to - No Target -. In the Entry section, 
click the up arrow for the Image/Class field. 
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n. Make sure that Font APEX Icons is selected in the Show drop-down list. 

 

o. Select fa-cube from the list. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

658  Practices for Lesson 17: Managing Application Navigation 

p. Click Apply Changes. 

 

q. Click Create Entry >. 

 

r. Select Manage Products for Parent List Entry, enter 22 for Sequence, and enter View 

Products for List Entry Label. In the Target section, make sure that Target type is set 

to Page in this Application and the Page is 7 (the page number corresponding to the 

Products page). Then click Create List Entry. 
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s. Select View Orders. 

 

t. In the Entry section, retain 30 for Sequence and enter Manage Orders for List Entry 

Label. In the Target section, set the Target type to - No Target -. In the Entry section, 
click the up arrow for the Image/Class field. 
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u. Make sure that Font APEX Icons is selected in the Show drop-down list. 

 

v. Select fa-dollar from the list. 
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w. Click Apply Changes. 

 

x. Click Create Entry >. 

 

y. Select Manage Orders for Parent List Entry, enter 32 for Sequence, and enter View 

Orders for List Entry Label. In the Target section, make sure that Target type is set to 

Page in this Application and the Page is 12 (the page number corresponding to the List 

of Orders page). Then click Create List Entry. 
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2. In the Home page, change the region template of Tasks to no template, the List Template to 

Navigation Bar, and the Page Template to Theme Default. 

a. Click 111 Application Breadcrumb. 

 

b. Open the Home Page. 
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c. In the Rendering tab, select the Tasks region. 

 

d. In the Region tab, make the following changes: 

 Layout > Sequence: Enter 5 

 Layout > Position: Select Content Body 

 Appearance > Template: Select - Select -  
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e. In the Rendering tab, select Tasks > Attributes. 

 

f. In the Attributes tab, change the List Template value to Navigation Bar. 
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g. In the Rendering tab, select Page 1: Home. 

 

h. In the Page tab, change the Appearance > Page Template value to Theme Default. 
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3. Run the page to see the Home Page List. Click the parent entry to show the sublist entries. 

a. Click the Save and Run Page icon. 

 

b. The page is displayed. Click any parent entry to see the sublist. 

 

c. Click the Application 111 link on the Developer toolbar. 
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Solution 17-2: Building a Database-Driven Report 

Overview 

In this practice solution, steps are provided for building a database-driven navigation report. 

Steps 

1. Create a new page with a Classic Report called List of Customers. 

a. In the GlobalMart Management Tool application home page, click Create Page >. 

 

b. Select Report. 
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c. Select Classic Report. 

 

d. Enter 21 for Page Number and List of Customers for Page Name. Click Next >. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

670  Practices for Lesson 17: Managing Application Navigation 

e. Accept the default and click Next >. 
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f. For Report Source, select SQL Query and enter the following query (located in the 

/home/oracle/labs/labs/lab_17_02.txt file). Click Create. 

SELECT cust_first_name||' '|| cust_last_name as Name, customer_id 

FROM oehr_customers 

 

The List of Customers Classic Report opens in Page Designer view. 

 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

672  Practices for Lesson 17: Managing Application Navigation 

2. Hide the CUSTOMER_ID column in the report and turn off pagination. Display the Customer 

Name column heading in blue by editing the column definition and entering the following for 

Column Heading. 

<font color=”blue”>CUSTOMERS</font> 

a. In the Rendering tab, select Regions > Content Body > Report 1 > Attributes. 
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b. In the Attributes tab, select No Pagination (Show All Rows) from the Pagination > Type 
drop-down list. 

 

c. In the Rendering tab, select Regions > Content Body > Report 1 > Columns > 

CUSTOMER_ID. 
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d. In the Column tab, select Identification > Type as Hidden Column. 

 

e. In the Rendering tab, select the NAME column. 

 
O

ra
cl

e 
In

te
rn

al
 &

 O
ra

cl
e 

Ac
ad

em
y 

U
se

 O
nl

y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 17: Managing Application Navigation  675 

f. In the Column tab, change the Identification > Heading to: 

<font color=”blue”>CUSTOMERS</font> 

 

g. Click Save. 

 

 

3. Create a link to the Customer Details page on the NAME column. Pass the P9_CUSTOMER_ID 

item from the Customer Details page with the value #CUSTOMER_ID# from this page. 

a. Ensure that the NAME column remains selected. In the Column tab, change 

Identification > Type to Link. 

 

b. Click the No Link Defined button under the Link subtab. 
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c. Select the Customer Details page for Page (in this case 9) by clicking the arrow to the 

right of the Page field. Under Set Items, select P9_CUSTOMER_ID for Name and 

CUSTOMER_ID for Value. Click OK. 

 

d. Under the Link section, ensure #NAME# appears for Link Text. 
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4. Run the page to see the database-driven report. 

a. Click the Save and Run Page icon. 

 

b. Click any one customer to view the details. 
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c. The Customer Details page is displayed for the customer. 

 

 

d. Click the Application 111 link on the Developer toolbar. 
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Solution 17-3: Building a Site Map 

Overview 

In this practice solution, steps are provided for building a site map. 

Steps 

1. Assign each page that you want in the site map to the same page group. Create a page group 

called Site Map and assign the following pages to the Site Map page group. 

Pages 

Customers 

Products 

List of Orders 

Customer Feedback 

Access Control 

Administration Page 

a. In the GlobalMart Management Tool home page, click Utilities. 
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b. Select Page Groups under Page Specific Utilities. 

 

c. Click Create >. 

 

d. Enter Site Map for Name and click Create. 
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e. Click the Page Assignments tab. 

 

f. Select Site Map from the New Group drop-down list. Then select the check box next to 
each of the following pages and click Assign Checked. 

Pages 

Customers 

Products  

List of Orders 

Customer Feedback 

Access Control 

Administration Page 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

682  Practices for Lesson 17: Managing Application Navigation 

 

Note that the image is truncated and not the complete list. 
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You get the Page Groups reassigned message.

 

 

2. Create a new page called Site Map with a Classic Report that shows only the pages in the Site 

Map page group. 

a. Click the Utilities breadcrumb. 

 

b. Select Application Express Views. 
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d. Select the APEX_APPLICATION_PAGES view. 

 

e. On the Select Columns tab, if PAGE_NAME is not included in the list on the right, then 

select PAGE_NAME column and click the right arrow (>) to move it to the columns selected 

list. Similarly, you do not want to display the WORKSPACE, WORKSPACE_DISPLAY_NAME, 

and APPLICATION_NAME. Select WORKSPACE, WORKSPACE_DISPLAY_NAME, and 

APPLICATION_NAME and click the left arrow (<) to move it to the column list on the left. 

Click Filter >. 

 

f. Select APPLICATION_ID for Column and enter 111 for Value (note that you need to 

replace 111 with your own application ID in case your application ID varies). In the next 

line, enter PAGE_GROUP for Column and enter ‘Site Map’ for Value. Click Results >. 
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g. Notice that the pages you selected earlier are on the list. Expand Query.  

 

h. Expand Query and select the query and copy it to your clipboard. 
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i. Click the Application Builder pull-down menu and select Database Applications. 

 

j. Select GlobalMart Management Tool application. 

k. Click Create Page >. 
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l. Select Report. 

 

m. Select Classic Report. 
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n. Enter 22 for Page Number and Site Map for Page Name and click Next >. 

 

o. Accept the default and click Next >. 
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p. Select SQL Query for Source Type. Paste your query in the SQL area and click Create. 
You can also copy and paste the query from the 

/home/oracle/labs/labs/lab_17_03.txt file. Note that you need to replace 111 

with your own application ID in the script. 

select APPLICATION_ID,PAGE_ID,PAGE_NAME 

  from APEX_APPLICATION_PAGES 

 where APPLICATION_ID = 111 

   and PAGE_GROUP = 'Site Map' 

 

The Site Map page opens in Page Designer view. 
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3. Change the Pagination Scheme to None and do not show the PAGE_ID column. Link the 

PAGE_NAME column to the #PAGE_ID# so that it opens the corresponding page when clicked. 

a. In the Rendering tab, under Regions, select Report 1 > Attributes. 
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b. Select No Pagination (Show All Rows) from the Pagination > Type drop-down list. 

 

c. In the Rendering tab, under Regions, select Columns > PAGE_ID. 
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d. In the Column tab, select Identification > Type as Hidden Column. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 17: Managing Application Navigation  693 

e. In the Rendering tab, under Regions, select Columns > APPLICATION_ID. In the 

Column tab, select Identification > Type as Hidden Column. 
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f. In the Rendering tab, under Regions, select Columns > PAGE_NAME. 
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g. In the Column tab, select Identification > Type as Link. Click the No Link Defined button 
under Link > Target. 

 

h. Make sure that Page in this application is selected for Target > Type and enter 

#PAGE_ID# in the Page text box. Click OK. 
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i. Ensure #PAGE_NAME# appears for Link Text and click the Save button. 

 

 

4. Add this page to your navigation bar and call it Site Map. 

a. Click the Shared Components icon. 

 

b. Select Navigation Bar List under Navigation. 
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c. Click Desktop Navigation Bar. 

 

d. Click Create Entry >. 

 

e. Enter Site Map for List Entry Label. Select your Site Map page number for Page (Page 

22) and click Create List Entry. 
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f. Change the Sequence of the Site Map such that it appears before Sign Off. Click Grid 
Edit. 
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g. Change the Sequence of Site Map to 8 and click Save. 

 

 

5. Run the page and click one of the page names to view the corresponding page. 

a. Click the Run Page 22 icon. 

 

b. Click one of the page names to view the corresponding page. 
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c. Click the Application 111 link on the Developer toolbar. 
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Solution 17-4: Enforcing Authorization in Site Map 

Overview 

In this practice solution, steps are provided for enforcing authorization in Site Map. 

Steps 

1. Navigate to SQL Workshop > SQL Commands. Copy and paste the code provided in step b 

(also located in the /home/oracle/labs/labs/lab_17_04_01.txt file) to create the 

authorization_check function. 

a. Click the SQL Workshop pull-down menu and select SQL Commands. 

 

b. Paste the following code (located in the 

/home/oracle/labs/labs/lab_17_04_01.txt file) to create the 

authorization_check function. Click Run. 

create or replace function authorization_check( 

p_scheme in varchar2) 

return varchar2 

is 

begin 

if apex_util.public_check_authorization(p_scheme) then 

return 'true'; 

else 

return 'false'; 

end if; 

end; 
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c. The function is created successfully. 
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d. Click the Application Builder pull-down menu and select Database Applications. 

 

 

2. For Site Map, change the Source for your Classic Report to the code in step d (also located in 

the /home/oracle/labs/labs/lab_17_04_02.txt file) so that only the pages that are 

authorized will be shown based on the user logged in. 

a. Click the GlobalMart Management Tool application icon. 

 

b. Select the Site Map page. 
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c. Under Regions, select Report 1. 

 

d. Paste the following code (located in the 

/home/oracle/labs/labs/lab_17_04_02.txt file) in the Source > SQL Query text 

box and click Save. 

select distinct PAGE_ID, PAGE_NAME 

from APEX_APPLICATION_PAGES p, apex_application_authorization a 

where p.APPLICATION_ID = :APP_ID 

and a.application_id = p.application_id 

and (p.authorization_scheme is null or 

(a.authorization_scheme_id = p.authorization_scheme_id and 

authorization_check(a.authorization_scheme_name) = 'true')) 

and PAGE_GROUP = 'Site Map' 
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Click 111 Application Breadcrumb. 
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3. You do not want end users or developers to see the Access Control Administration page. Make 

sure that the Authorization Schemes for this page is set to access control - Administrator. 

Run the page to see if only an authorized user can view it. 

a. Select the Access Control Administration page and click to open in Page Designer view. 

 

b. Under Security > Authorization Scheme, ensure that Administration Rights is selected. 
Note that Administration Rights is selected by default. 

   

 

c. Enter the page number of the Site Map Page and click Go. 
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d. The Site Map page opens in Page Designer view. Click Save and Run Page icon. 
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e. You are currently logged in as apex_dev. Sign off and log in as Susie Parker. 

 

 

f. Notice that when you are currently logged in as susie.parker due to which you currently 

see the Access Control Administration Page in the site map list. Click Sign Off. 
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g. To check the Site Map as a developer, sign in as brad.knight. 

 

h. In the navigation bar, click Site Map. 

 

Brad Knight does not have access to the Access Control Administration page, so you no 
longer see it in the Site Map list. 
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i. Click the Application 111 link on the Developer toolbar. 
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Practices for Lesson 18: Overview 

Practices Overview 

In these practices, you add advanced features to your application by creating Data Load Wizard 

pages and upload and download pages. 
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Practice 18-1: Creating Data Load Wizard Pages 

Overview 

In this practice, you create a series of wizard pages to upload data into the 

PRODUCT_INFORMATION table. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 
section of this practice. 

Tasks 

1. You create a series of wizard pages to upload data into the OEHR_PRODUCT_INFORMATION 

table. 

2. Test the upload by using the following data (located in the 

/home/oracle/labs/labs/lab_18_01.txt file). Use the Copy and Paste Delimited Data 

area. 

PRODUCT_ID PRODUCT_NAME PRODUCT_DESCRIPTION CATEGORY_ID

 WEIGHT_CLASS WARRANTY_PERIOD SUPPLIER_ID

 PRODUCT_STATUS LIST_PRICE MIN_PRICE 

3194 LED Monitor 15/PM Light Emitting Diode 15 inch passive 

monitor. The virtually-flat, high-resolution screen delivers 

outstanding image quality with reduced glare. 11 3 +03-00

 102067 under development 259 208 

3195 LCD Monitor 20/PM Liquid Cristal Display 20 inch passive 

monitor. Enjoy the productivity that a small monitor can bring via 

more workspace on your desk. Easy setup with plug-and-play 

compatibility 11 3 +03-00 102061 orderable 249

 206 

3196 Plastic Stock - B/HD Plastic Stock - Black, high density. 39

 1 +03-00 103095 orderable 3 2 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Log in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 
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If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 18-1. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Log in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 
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If you haven’t completed Practice 17- 4, perform the following steps: 

a. Log in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_17_04.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 18-2: Adding an Upload and Download Page 

Overview 

In this practice, you create a form in an HTML region with a file upload item and a button. The 
button will submit the page and return the user to the same page. Also, you create a report on the 
document table that has links to download documents. Provide links to download the documents in 
the report. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 
section of this practice. 

Tasks 

1. Create a blank page called Upload Download Files with an HTML region called Submit File 

that contains a File Browse item type on the source type APEX_APPLICATION_TEMP_FILES. 

Create a Submit button and upload the OracleLogo.png file from the 

/home/oracle/labs/labs directory. 

Note that every time you upload a script in SQL Workshop or upload a file in Shared 
Components for an application, the reference to the file is placed in the 

APEX_APPLICATION_TEMP_FILES table. 

2. Create an Interactive Report subregion called Uploaded Files with the following SQL query 

(located in /home/oracle/labs/labs/lab_18_02.txt): 

SELECT id, filename FROM APEX_APPLICATION_TEMP_FILES order by 

created_on desc 

3. Modify the report to create a link on the ID column to download the file. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Log in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 18-2. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Log in to the Application Express workspace as the apex_dev user. 
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b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 18-1, perform the following steps: 

a. Log in to the Application Express workspace as the apex user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_18_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 
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h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 18-1: Creating Data Load Wizard Pages 

Overview 

In this practice, you create a series of wizard pages to upload data into the 

OEHR_PRODUCT_INFORMATION table. 

Steps 

1. You create a series of wizard pages to upload data into the PRODUCT_INFORMATION table. 

a. In the GlobalMart Management Tool application home page, click Create Page >. 

 

b. Select the Data Loading page type. 
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c. Enter the following and click Next >.  

 Data Load Definition: Select Create New 

 Definition Name: Enter Load Products 

 Owner: OEHR 

 Table Name: Select OEHR_PRODUCT_INFORMATION (table) 

 Unique Column > Column 1: Select PRODUCT_ID (Number)  
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d. You want to create a rule that will change the Product Name to uppercase. Select 
PRODUCT_NAME (Varchar2) and click the right arrow (>) to select it to bring to the right 

column. Enter Product Name in Uppercase for Rule Name. Select To Upper Case 

for Type. Click Add Transformation. 
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e. The rule is added. Click Next >. 

 

f. You do not want to create a table lookup. Click Next >. 
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g. Set the page numbers to 23, 24, 25, and 26 (as shown in the screenshot) and click Next 

>. 
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h. You want to create a new navigation menu entry. Select Create a new navigation menu 

entry and ensure that Data Loading is selected for the New Navigation Menu Entry. 

Click Next >. 
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i. You need to specify which page to go to when you click Cancel and Finish. Enter 1 (Home 

Page) for both the Cancel Button Branch to Page and Finish button Branch to Page. 
You are now ready to create the Data Load Wizard pages. Click Create. 

 

j. Once the Data Load Wizard is created, you get the following message:  

  

k. Because Data Load Wizard Pages cannot be run directly, navigate to the GlobalMart 
Management Tool application home page and then run the application. Click Application 
111 Breadcrumb. 
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l. Click Run Application. 

 

 

2. Test the upload by using the following data (located in the 

/home/oracle/labs/labs/lab_18_01.txt file). Use the Copy and Paste Delimited Data 

area. 

PRODUCT_ID PRODUCT_NAME PRODUCT_DESCRIPTION CATEGORY_ID

 WEIGHT_CLASS WARRANTY_PERIOD SUPPLIER_ID

 PRODUCT_STATUS LIST_PRICE MIN_PRICE 

3194 LED Monitor 15/PM Light Emitting Diode 15 inch passive 

monitor. The virtually-flat, high-resolution screen delivers 

outstanding image quality with reduced glare. 11 3 +03-00

 102067 under development 259 208 

3195 LCD Monitor 20/PM Liquid Cristal Display 20 inch passive 

monitor. Enjoy the productivity that a small monitor can bring via 

more workspace on your desk. Easy setup with plug-and-play 

compatibility 11 3 +03-00 102061 orderable 249

 206 

3196 Plastic Stock - B/HD Plastic Stock - Black, high density. 39

 1 +03-00 103095 orderable 3 2 

a. On the Sign in page, enter the apex_dev user credentials and click Sign In. 
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b. Click Data Load in the navigation menu of the GlobalMart Management Tool application 
home page. 
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c. The first wizard page is where you specify the Data Load Source. You want to copy and 

paste the following text located in the /home/oracle/labs/labs/lab_18_01.txt file 

into the Copy and Paste Delimited Data area. Ensure that the Separator includes ‘\t’ (tab 
space) and ensure that the check box for First Row has Column Names is selected. 
Then click Next >. 
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d. Data/Table Mapping is displayed. Make sure that the Column Names for all the columns 
are selected. Otherwise, select the corresponding column names from their respective pull-
down menus and click Next. 

 

e. The Data Validation page is displayed. This page displays the data that will be inserted 

and/or updated into the database. Notice that the PRODUCT_NAME was transformed to all 

uppercase. Click Load Data. 
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f. Notice that three rows are inserted. Click Finish. 
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g. Switch to the Page Designer window in your browser. Click SQL Workshop and select 
Object Browser. 
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h. In Object Browser, select the OEHR_PRODUCT_INFORMATION table. 

 

i. The OEHR_PRODUCT_INFORMATION table definition is displayed. Click the Data tab. 
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j. Click the Query button 

 

k. Select all columns and enter 3194 in the Column Condition field for PRODUCT_ID. 

 

l. Scroll down and click Query. 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

Practices for Lesson 18: Extending Your Application  735 

m. The newly inserted row with PRODUCT_ID 3194 is displayed. Click < New Query. 

 

n. Make sure that all the columns are selected and enter 3195 in the Column Condition field 

for PRODUCT_ID. 
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o. Scroll down and click Query. 
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p. The newly inserted row with PRODUCT_ID 3195 is displayed. Click < New Query. 

 

q. Select all columns and enter 3196 in the Column Condition field for PRODUCT_ID. 
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r. Scroll down and click Query. 

 

s. The newly inserted row with PRODUCT_ID 3196 is displayed. 
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Solution 18-2: Adding an Upload and Download Page 

Overview 

In this solution, you create a form in an HTML region with a File Upload item and a button. The 
button will submit the page and return the user to the same page. Also, you create a report on the 
document table that has links to download documents. Provide links to download the documents in 
the report. 

Steps 

1. Create a blank page called Upload Download Files with an HTML region called Submit File 

that contains a File Browse item type on the source type APEX_APPLICATION_TEMP_FILES. 

Create a Submit button and upload the OracleLogo.png file from the 

/home/oracle/labs/labs directory. 

Note that every time you upload a script in SQL Workshop or upload a file in Shared 
Components for an application, the reference to the file is placed in the 

APEX_APPLICATION_TEMP_FILES table. 

a. Click the Application Builder pull-down menu in the navigation bar and select Database 
Applications. 

b. Click the GlobalMart Management Tool application icon. 
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c. Click Create Page >. 

 

d. Select the Blank Page page type. 
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e. Enter Page Number as 27. For Name, enter Upload Download Files and click Next 

>. 

 

f. Leave the defaults for the Navigation Preference and click Next >. 
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g. Click Finish. 
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h. The Upload Download Files page is created, and it opens in the Page Designer view. 
Drag Static Content < / > region from Regions gallery to the Content Body of the  
Layout tab. 
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i. Ensure that the newly created region is selected in the Rendering tab. 

 

j. In the Region panel, enter Submit File for Identification > Title. 

 

k. Drag File Browse item from Items gallery to Items in Content Body on the Layout of the 
page. 
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l. Ensure that the new item is selected in the Rendering tab. 
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m. In the Page Item tab, enter the following values for the respective fields: 

 Identification > Item Name: Enter P27_FILE_NAME 

 Settings > Storage Type: Select Table APEX_APPLICATION_TEMP_FILES (if not 

selected by default) 

 
After you define the attributes, this is how it looks in the Layout tab: 
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n. You want to create a Submit button that will perform the upload. Drag Text with Icon from 

Buttons gallery to the P27_FILE_NAME item in the Submit File region on the Layout tab. 

 

o. Enter P27_SUBMIT for Identification > Button Name and Submit for Identification > 

Label. 

 

p. Select Yes for Appearance > Hot. 
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q. Under Appearance > Template Options, click Use Template Defaults, Right. The 
Template Options dialog opens. 

 

r. In the Template Options dialog, select Large for Size and click OK. 
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s. Click the Save and Run Page icon. 

 

t. The GMT app opens. Click the Browse icon in the File Name field. 

 

u. Select the /home/oracle/labs/labs/OracleLogo.png file and click Open. 
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v. Click Submit to upload the file. 

 

w. The file is submitted. At this point, you want to create a report to show the list of files that 
are uploaded already. Click Edit Page 27 on the Developer toolbar to open Page 27 in 
Page Designer. 
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2. Create an Interactive Report subregion called Uploaded Files with the following SQL query 

(located in /home/oracle/labs/labs/lab_18_02.txt): 

SELECT id, filename FROM APEX_APPLICATION_TEMP_FILES order by 

created_on desc 

a. You will create the report as a subregion. Right-click the Submit File region and select 
Create Sub Region. 
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b. Ensure that the new subregion is selected in the Rendering tab. 

 

c. In the Region tab, enter the following values for the respective fields: 

 Identification > Title: Uploaded Files 

 Identification > Type: Select Interactive Report 

 Source > Type: Select SQL Query 

 Source > SQL Query: Copy the SQL query from 

/home/oracle/labs/labs/lab_18_02.txt and paste here. 
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d. Click the Save and Run Page. 
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e. The report that you just created shows all the documents that have been uploaded. Note 
that your list may be different depending on what you uploaded. Next, you provide a link to 
download the document. Click Edit Page 27 on the Developer toolbar. 
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3. Modify the report to create a link on the ID column to download the file. 

a. In the Rendering tab, select Uploaded Files > Attributes. 

 

b. In the Attributes tab, under Link > Link Column. Select Link to Custom Target. 
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c. Under Link > Target, click No Link Defined. The Link Builder - Target dialog opens. 

 

d. In the Link Builder - Target dialog, select URL for Target > Type and enter p?n=#ID# for 

URL. Click OK. 
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e. Click the Save and Run Page icon. 

 

f. The report is displayed with a link indicated by the pencil icon to open and download the 
file. Click the Application 111 link on the Developer toolbar. 
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Practices for Lesson 19: Overview 

Practices Overview 

In these practices, you will learn how to create and modify charts for your applications. 
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Practice 19-1: Creating and Modifying Charts 

Overview 

In this practice, you create a new Horizontal Bar – 3D Bar chart. You then modify the chart and 
change it to a Vertical Bar chart and change some of the settings to see how they work. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create a new chart page that includes a Horizontal Bar chart. Use Employees by 

Department for the Title, Departments for the X-Axis, and Number of Employees for the 

Y-Axis. Use the following query (located in /home/oracle/labs/labs/lab_19_01.txt). 

Test your page. 

select null link, 

department_name chart_label, 

count(*) chart_value 

from oehr.oehr_employees e, 

oehr_departments d 

where e.department_id = d.department_id 

group by department_name 

2. Modify your chart and change it to a Vertical Bar chart. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select apex_admin SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 19-1. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 
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b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 18-3, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_18_03.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 
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h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install.  

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 19-2: Creating Pie and Doughnut Charts  

Overview 

In this practice, you create a Pie chart and then change it to a Donut chart for the GMT application. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create a Pie chart. Use Departments Chart for the Title. Use the following query (located in 

/home/oracle/labs/labs/lab_19_02.txt). Then change the Pie chart to a Donut chart. 

select null link, 

department_name chart_label, 

count(*) chart_value 

from oehr.oehr_employees e, 

oehr_departments d 

where e.department_id = d.department_id 

group by department_name 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 19-2. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 
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e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 19-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_19_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Practice 19-3: Creating Combination Chart 

Overview 

In this practice, you create some additional charts, such as a combination chart of a Line and Bar 

chart for the GlobalMart Management Tool application. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. You build a Combination chart. First, you upload and run the add_employees3.sql script to 

create a table called employees3. 

2. Create a Combination chart named Salary Commission Combined Chart. Use the 

following SQL Query (located in the /home/oracle/labs/labs/lab_19_03_01.txt file). 

Specify Employee for X-Axis Title and Salary for Y-Axis Title. Edit the chart by changing the 

Series attribute to Line. 

SELECT NULL LINK, 

LAST_NAME LABEL,  

SALARY "Salary", 

COMMISSION_PCT "COMMISSION" 

FROM EMPLOYEES3 

WHERE MANAGER_ID = 100 

Order by LAST_NAME 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 19-3. 

 

If you haven’t completed Practice 16-2, perform the following steps: 
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a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 19-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_19_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 
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i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 19-1: Creating and Modifying Bar Charts 

Overview 

In this practice solution, steps are provided for creating and modifying charts. 

Steps 

1. Create a new bar chart page that includes a Horizontal Bar. Use Employees by 

Department for the Title, Departments for the X-Axis, and Number of Employees for the 

Y-Axis. Use the following query (located in /home/oracle/labs/labs/lab_19_01.txt). 

Test your page. 

select null link, 

department_name chart_label, 

count(*) chart_value 

from oehr.oehr_employees e, 

oehr_departments d 

where e.department_id = d.department_id 

group by department_name 

 

a. In the GlobalMart Management Tool application home page, click Create Page >. 
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b. Select Chart. 

 

c. Select Bar for Chart Type. Click Next >. 
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d. For Page and Region Attributes, enter the Page Name Employees by Department and 

click Next >. The Page Number is 28. 

 

e. Accept the defaults for Navigation Preference and click Next >. 
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f. For Source Type, select SQL Query and enter the following SQL Query.  

select null link, 

department_name chart_label, 

count(*) chart_value 

from oehr.oehr_employees e, 

oehr_departments d 

where e.department_id = d.department_id 

group by department_name 

After entering the SQL Query, validate the query by clicking the Validate icon. Click Next>. 
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g. For Column Mapping, enter the following and click Create. 

 Orientation: Select Horizontal 

 Label Column: Select CHART_LABEL 

 Value Column: Select CHART_VALUE 
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h. The chart is created and opens in Page Designer view.  

  

 

i. Set the names for x axis and y axis as follows: In the Rendering tab, expand click Axes 
and define the following: 

 Click x. On the Property Editor, enter Departments for Title.  

 Click y.  On the Property Editor, enter Number of Employees for Title. 
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j. Run the page by clicking the Save and Run Page icon. 
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k. Place your cursor over one of the bars to see the department and its value. 

 

Note: You might need to activate the Adobe Flash plug-in. 

l. You now change the Horizontal Bar chart to a Vertical Bar chart and alter the way it looks. 
Click the Edit Page 28 link on the Developer toolbar. 

 

 

3. Modify your chart and change it to a Vertical Bar Chart. 

a. In the Rendering tab, select Attributes under Regions > Content Body > Employees by 
Department. On the Property Editor, under Appearance, select Vertical for Orientation. 
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b. Click the Save and Run Page icon. 

 

c. Notice that the chart is now a Vertical Bar chart. Click the Application 111 link on the 
Developer toolbar. 
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Solution 19-2: Creating a Pie Chart and Converting it to a Doughnut 

Chart 

Overview 

In this practice solution, steps are provided for creating a Pie chart for the GMT application. 

Steps 

1. Create a Pie chart and then convert it to a Donut chart. Use Departments Chart for the Title. 

Use the following query (located in /home/oracle/labs/labs/lab_19_02.txt).  

select null link, 

department_name chart_label, 

count(*) chart_value 

from oehr.oehr_employees e, 

oehr_departments d 

where e.department_id = d.department_id 

group by department_name 

 

a. In the GlobalMart Management Tool application home page, click Create Page >. 
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b. For Page Type, select Chart and click Next >. 

 

c. Select Pie for Chart Type and click Next >. 
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d. For Page and Region Attributes, enter 29 for Page Number and Departments Chart 

for Page Name. Click Next >. 

 

e. Accept the default and click Next >. 

 

f. For Source, select SQL Query and enter the following SQL query (located in 

/home/oracle/labs/labs/lab_19_02.txt) and click Next >. 

select null link, 

department_name chart_label, 

count(*) chart_value 

from oehr.oehr_employees e, 

oehr_departments d 

where e.department_id = d.department_id 

group by department_name 
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g. For Column Mapping, define the following values and click Create.  

 Label Column: Select CHART_LABEL 

 Value Column: Select CHART_VALUE 

 

h. The page now opens in Page Designer. Click the Save and Run Page icon. 

 

i. You may be asked to sign in. Enter your login credentials and click Sign In. 
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j. The Departments Chart pie chart is displayed. Switch the window to the Page Designer 
page. 

 

 

2. To convert the Pie chart to a Donut chart: 

a. Go to the Page Designer view of the Pie chart, and in the Rendering tab, click Attributes. 
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b. On the Property Editor, change the Chart Type to Donut. 
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c. Click Save and Run. The Donut chart is now created. Hover your mouse over the different 

departments in the chart. 

 

d. Click Application 111 on the Developer toolbar. 
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Solution 19-3: Creating Combination Chart 

Overview 

In this practice solution, steps are provided for creating a Combination chart for the GlobalMart 

Management Tool application. 

Steps 

1. You build a Combination chart. First, you upload and run the add_employees3.sql script to 

create a table called employees3. 

a. Click the arrow in the SQL Workshop pull-down menu and select SQL Scripts. 

 

b. Click Upload >. 
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c. Browse and select the /home/oracle/labs/labs/add_employees3.sql file and 

click Upload. 

 

d. Click the Run icon in the new row to create the employees3 table. 

 

  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

788  Practices for Lesson 19: Creating and Editing Charts 

e. Click Run Now. 

 

f. Click the View Results icon. You can view the results, as shown in the screenshot here. 
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g. Click the arrow in the Application Builder pull-down menu and select Database 
Applications. 

 

 

2. Create a Combination chart named Salary Commission Combined Chart. Use the 

following SQL Query (located in the /home/oracle/labs/labs/lab_19_03_01.txt file). 

Specify Employee for X-Axis Title and Salary for Y-Axis Title. Edit the chart by changing the 

Series attribute to Line. 

SELECT NULL LINK, 

LAST_NAME LABEL,  

SALARY "Salary", 

COMMISSION_PCT "COMMISSION" 

FROM EMPLOYEES3 

WHERE MANAGER_ID = 100 

Order by LAST_NAME 

a. Click the GlobalMart Management Tool application icon to navigate to the home page. 
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b. In your application, click Create Page >. 

 

c. Select Chart for Page Type. 
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d. For Chart Type, select Combination and click Next >. 

 

e. Enter 30 for Page Number and Salary Commission Combined Chart for Page 

Name and click Next >. 
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f. For Navigation Menu:  

 Navigation Preference: Select Create a new navigation menu entry.  

 New Navigation Menu Entry, by default Salary Commission Combined Chart 

is selected.  

 Parent Navigation Menu Entry: Select – No parent selected - . 

 Click Next >. 

 

g. For data source of this Combination chart, use the following SQL query (located in the 

/home/oracle/labs/labs/lab_19_03_01.txt) to enter in the SQL Query text area. 

Click Next >. 

SELECT NULL LINK, 

LAST_NAME LABEL,  

SALARY "Salary", 

COMMISSION_PCT "COMMISSION" 

FROM EMPLOYEES3 

WHERE MANAGER_ID = 100 

Order by LAST_NAME 
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h. For Column Mapping, enter the following:  

 Orientation: Select Vertical. 

 Label Column: Select LABEL. This is the value for the x axis of the chart. 

 Value Column: Select Salary. This is the value for the y axis of the chart. 

 Click Create.  
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i. The Combination chart is created, and the page opens in Page Designer. Go to the 
Rendering tab in Page Designer. Observe that only one series, that is Series 1, is created. 
Click Series 1 to view its details in Property Editor. It shows that the chart for Series 1 is a 
Bar chart. The x-axis and y-axis do not contain any label, as you can see in the chart.  

  

j. Click the Save and Run Page icon. 
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k. Observe that although you have selected Combination chart for Chart Type, while 
creating, it has only generated a Vertical Bar chart depicting the salary of employees. To 
create the second chart to be included in the Combination chart, you have to create 
another series to depict the commission so that both the charts for the two series – salary 
and commission, are depicted in the same Combination chart. Click Edit Page 30 on the 
Developer toolbar. 

 

l. Rename Series 1 to Salary and change the Bar chart to a Line chart. To do so, go to the 

Rendering tab and click Series 1. In the Property Editor, enter Salary in the Name field 

to rename the chart. Select Line for Identification > Type. 
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m. Create the second series for a Bar chart to depict the commission. On the Rendering tab, 
right-click Series and select Create Series.  

 

n. On the Property Editor, under Identification enter the following:  

 Name: Enter Commission 

 Type: Select Bar 
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o. For Source of the Bar chart, define the following: 

 Type: Select SQL Query 

 Source: Enter the following SQL Query (located in the 

/home/oracle/labs/labs/lab_19_03_02.txt):  

SELECT NULL LINK, 

LAST_NAME LABEL,  

SALARY "Salary", 

COMMISSION_PCT "COMMISSION" 

FROM EMPLOYEES3 

WHERE MANAGER_ID = 100 

 

p. For Column Mapping, define the values for Label and Values as follows:  

 Label: Select LABEL 

 Value: Select Commission 
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q. Now, go to the Rendering tab to name the x-axis and y-axis as Employees and 
Salary/Commission, respectively.  

 Click x. Under Identification in Property Editor, enter Employees for Title. 

  

 Click y: Under Identification in Property Editor, enter Salary/Commission for Title. 
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r. In the Rendering tab, click Attributes. On the Property Editor, scroll down to Legend and 

click Yes for Show. For Title, enter Salary and Commission. 

  

s. Click the Save and Run Page icon. 
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t. You can now see a combination of salary as Line and commission as Bar charts. 

 
Place your cursor over one of the points in the Line chart to view the details. 

 
Click Application 111 on the Developer toolbar. 

 

  
O

ra
cl

e 
In

te
rn

al
 &

 O
ra

cl
e 

Ac
ad

em
y 

U
se

 O
nl

y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

802  Practices for Lesson 19: Creating and Editing Charts 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Practices for Lesson 20: Adding 

Calendars and Trees 

 

 
 
 
 
 
 
 
 
 
 
 
  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

804  Practices for Lesson 20: Adding Calendars and Trees 

Practices for Lesson 20: Overview 

Practices Overview 

In these practices, you will create a calendar page that displays the order total per day, create a 

calendar for the GMT application, and create a new page with a tree region and link to the Dynamic 

Employee Details page. 
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Practice 20-1: Creating a Calendar 

Overview 

In this practice, you create a calendar page that displays the order total per day. You also add a link 
to the page to be able to edit the details of an order. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 
section of this practice. 

Tasks 

1. Create a new Calendar page called Order Calendar. Base the calendar on the ORDERS table 

and set the Date Column to ORDER_DATE and Display Column to ORDER_TOTAL. Allow for 

dragging order total to different dates. Create links to Orders form so that you can create and 

edit the columns in the ORDERS table. Test your pages. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 20-1. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 
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h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 19-3, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_19_03.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 

Note: 

 You must also upload and run the add_employees3.sql script (browse and select the 

/home/oracle/labs/labs/add_employees3.sql file) to create a table called 

employees3 (for running the Combination chart). 
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Practice 20-2: Creating a Tree  

Overview 

In this practice, you create a new page with a tree region and link it to the Dynamic Employee 

Details page. Add a button on the Dynamic Employee Details page to link back to the tree page. 

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create a tree page called Employees by Manager that uses the default tree template. Select 

the appropriate options in the wizard so that the current query (located in 

/home/oracle/labs/labs/lab_20_02.txt) looks as follows:  

select case when connect_by_isleaf = 1 then 0 

when level = 1   then 1 

else     -1 

end as status, 

level, 

"LAST_NAME" as title, 

null as icon, 

"EMPLOYEE_ID" as value, 

null as tooltip, 

null as link 

from "OEHR"."EMPLOYEES" 

start with "MANAGER_ID" is null 

connect by prior "EMPLOYEE_ID" = "MANAGER_ID" 

order siblings by "LAST_NAME" 

2. Add a button to the Employee by Department page called Employee Hierarchy that 

navigates to the Employees by Manager tree page. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 
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f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 20-2. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 

s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 20-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 
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c. Click the Browse button. 

d. Browse and open the sol_20_01.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 

 

Note: 

 You must also upload and run the add_employees3.sql script (browse and select the 

/home/oracle/labs/labs/add_employees3.sql file) to create a table called 

employees3 (for running the Combination chart). 
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Solution 20-1: Creating a Calendar 

Overview 

In this practice solution, steps are provided for creating a calendar for the GlobalMart Management 

Tool application. 

Steps 

1. Create a Calendar page called Order Calendar. Create the calendar based on the 

OEHR_ORDERS table and set the Date Column to ORDER_DATE and Display Column to 

ORDER_TOTAL. Allow for dragging order total to different dates. Create links to the Orders form 

page so that you can create new entries and edit the columns in the OEHR_ORDERS table. Test 

your pages. 

a. Select the GlobalMart Management Tool application. 

 

b. Click Create Page >. 
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c. Select Calendar for page type. Click Next >. 
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d. In the Page Attributes dialog, define the following and click Next >: 

 Page Number: Enter 31 

 Page Name: Enter Orders Calendar 

 Breadcrumb: Select Breadcrumb 

 Parent Entry: Select Home (page 1) 

 Entry Name: Orders Calendar (selected by default) 

 

e. For Navigation Preference, define the following and click Next >. 

 Navigation Preference: Click Create a new navigation menu entry 

 New Navigation Menu Entry: Orders Calendar (selected by default) 

 Parent Navigation Menu Entry: Select Home 
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f. Select Source Type as Table. From the Table / View Name drop-down list, select 

OEHR_ORDERS (table). By default, all the columns are selected. Click Next >. 
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g. Select ORDER_TOTAL for Display Column and ensure ORDER_DATE is selected for Start 

Date Column. Click Create. 

 

h. The Order Calendar is created, and it opens in Page Designer. This completes the task of 

creating the Order Calendar based on the OEHR_ORDERS table and setting the Display 

Column and the Start Date Column to ORDER_TOTAL and ORDER_DATE, respectively.  

i. Now, in Page Designer, define the attributes for Primary Key:  
Click Attributes under Order Calendar on the Rendering tab. In the Property Editor on the 

right pane, under Settings, set the Primary Key Column to ORDER_ID. 

 

j. To enable drag and drop of calendar entries, select Attributes on Rendering tab. On the 

right pane under Settings, click Yes for Drag and Drop and enter the following code, 

(located in /home/oracle/labs/labs/lab_20_01.txt):  

BEGIN 

    UPDATE "OEHR_ORDERS" 

    SET "ORDER_DATE" = to_date(:APEX$NEW_START_DATE, 

'YYYYMMDDHH24MISS')               

    where "ORDER_ID" = :APEX$PK_VALUE; 

END; 
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k. To define links to Orders form page in your calendar, under Settings, click No Link 
Defined under Create Link. 

 

l. In the Link Builder - Create Link dialog, define the following: 

 Type: Select Page in this application 

 Page: Select page 13 (Oehr Orders page) 

 Under Set Items, select P13_ORDER_ID for Name. 

 Click OK. 
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m. To define links to Orders form page in your calendar, under Settings, click No Link 
Defined under View / Edit Link. 

 

n. In the Link Builder – View/Edit Link dialog, define the following:  

 Type: Select Page in this application 

 Page: Select page 13 (Oehr Orders page) 

 Under Set Items, select P13_ORDER_ID for Name and select &ORDER_ID for Value. 
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 Click OK. 

 

o. Click Save and Run Page icon. 
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p. If prompted, enter your developer credentials. 
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q. The Orders Calendar that you created now opens. Find a month where there is an order 
total listed for a particular day (for example: April 2019). Click the amount link for the entry 
on April 4, 2019. 

 

r. Change the Order Date to a different date in the same month by using the Date Picker. 

For example, change the order date to April 10, 2019, and click Apply Changes. 
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s. The change is applied. Note that the Order Total has moved to the date you changed it to, 
that is, to April 10, 2019. 
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t. You can also drag an order total to a different day. Drag the order total from April 8, 2019, 
to April 16, 2019. Note that after you release your mouse, the order total moves to the new 
location. 

 

 

u. Click the Application 111 link on the Developer toolbar. 

 

To learn more about what you can do with calendaring, install the Sample Calendars 

packaged application. 

 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

822  Practices for Lesson 20: Adding Calendars and Trees 

Solution 20-2: Creating a Tree  

Overview 

In this practice solution, steps are provided for creating a new page with a tree region and linking it 

to the Dynamic Employee Details page in the GMT application. 

Steps 

1. Create a tree page called Employees by Manager that uses the default tree template. Select 

the appropriate options in the wizard so that the current query (located in 

/home/oracle/labs/labs/lab_20_02.txt) looks as follows: 

select case when connect_by_isleaf = 1 then 0 

when level = 1   then 1 

else     -1 

end as status, 

level, 

"LAST_NAME" as title, 

null as icon, 

"EMPLOYEE_ID" as value, 

"FIRST_NAME" as tooltip, 

null as link 

from "OEHR"."OEHR_EMPLOYEES" 

start with "MANAGER_ID" is null 

connect by prior "EMPLOYEE_ID" = "MANAGER_ID" 

order siblings by "LAST_NAME" 

a. In the GMT application home page, click Create Page >. 
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b. Select the Tree option and click Next>. 

 

c. In the Page Attribute section of the wizard, enter the following: 

 In the Page Number field, the applicable page number is allotted as applicable. In this 

example, it is 32. 

 For Page Name and Region Name, enter Employees by Manager. 

 

d. Click Next >. 
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e. For navigation preference: 

 For Navigation Preference, select Create a new navigation menu entry. 

 For New Navigation Menu Entry, ensure that the entry Employees by Manager is 

selected. 

 For Parent Navigation Menu Entry, select Home. 

 

 Click Next >. 

f. For Table/View Owner Name, select OEHR_EMPLOYEES (table) and click Next >. 
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g. For Query, select the following values for the respective fields (some are populated by 
default) and click Next >: 

 ID: Select EMPLOYEE_ID (Number) 

 Parent ID: Select MANAGER_ID (Number) 

 Node Text: Select LAST_NAME (Varchar2) 

 Start With: Select MANAGER_ID (Number) 

 Start Tree: Value is NULL 
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h. You can see the query that is generated by expanding the Current Query tab in the Where 

and Order by section of the wizard. Note that in the Order Siblings By field, LAST_NAME 

(Varchar2) is selected. Click Next >. 
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i. In the Tree Attributes section, select Database Column for Tooltip and FIRST_NAME 

(Varchar2) for Tooltip Column.  

 

j. Click Next >. 
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k. In the Confirm section of the wizard, click Create. 

  

l. The page for the Employees by Manager tree opens in Page Designer. Click the Save and 
Run Page icon. 
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m. Expand one of the manager nodes. Notice that when you place your cursor over one of the 

names, you see the FIRST_NAME of the person as a tooltip. 

 

n. Click the Application 111 link on the Developer toolbar. 
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2. Add a button to the Employee by Department page called Employee Hierarchy that 

navigates to the Employees by Manager tree page. 

a. Click the Chart page 28- Employees by Department. 

 

b. In the Rendering tab, right-click Employees by Department region and click Create 
Button. Alternatively, you can drag a HTML button into the Employees by Department 
region from the Buttons gallery. 
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c. In the Button tab, enter the following values for the respective fields in Property Editor 

 Identification > Button Name: Enter  Employee_Hierarchy 

 Identification > Label: Employee Hierarchy This field is auto-populated. 

 Layout > Button Position: Select  Above Region 

 Behavior > Action: Click  Redirect to Page in this Application 

 Behavior > Target > Page: 32 (Page number of the Employees by Manager page) 

and click OK. 

 

 

d. Click Save and Run.  
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e. The Employees by Department page now has the Employee Hierarchy button. 

Click Employee Hierarchy in the Employees by Department chart. 

 

f. It opens the Employees By Manager tree under Home. Click the Application 111 

link on the Developer toolbar. 

 

 
 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Practices for Lesson 21: 

Managing Application Feedback 

 

 
 
 
 
 
 
 
 
 
 
 
  

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

834  Practices for Lesson 21: Managing Application Feedback 

Practices for Lesson 21: Overview 

Practices Overview 

There is one practice in this lesson. In this practice, you will create a feedback form in your 

application, submit feedback, and review and categorize the feedback. 
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Practice 21-1: Adding and Monitoring Feedback in Your Application 

Overview 

In this practice, you create a feedback form in your application, submit feedback, and review and 

categorize the feedback.  

Note: The solution script (sol_21_01.sql) generated at the end of this practice is just a starting 

point for this practice and not the solution.  

Assumptions 

You have completed the previous practices.  

Note: If you haven’t completed the previous practices, execute the steps mentioned in the Catch Up 

section of this practice. 

Tasks 

1. Create a feedback form for your GMT application. 

2. Create the following feedback from your application: 

Feedback # Feedback Text Experience Feedback Type 

1. The date format on the Orders form 

needs to be changed from dd-mm-yy 

to mm-dd-yyyy 

Neutral General 

Comment 

2. Excellent application. Very user-friendly 

and intuitive UI.  

Positive General 

comment 

3. Error when deleting a line item on an 

order 

Negative Bug 

4. Add label help text on Orders page Neutral General 

comment 

3. Review your feedback on the GMT application home page. 

4. Review your feedback on the Team Development page. 

5. Log feedback 1 (“Date format needs to be changed on Master detail”) as a Feature with a 

status of “Functionally complete - 80%.” 

6. Acknowledge feedback 2 (“Excellent application. Very user-friendly and intuitive UI.”) 

7. Log feedback 3 (“Error when deleting a line item on an order”) as a bug. Set the severity to “3. 

Significant Impact” and assign it to brad.knight. 

8. Edit the bug and change the status to “80. Fixed in development” and set the priority to “1. As 

soon as possible.” 

9. Log feedback 4 (Add label help text on Orders page) as a To Do, assign it to susie.parker, 

and change the status to “Assigned - 30%.” Delete the feedback entry after logging it as a To 

Do. 
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10. Edit the To Do, changing the status to “Work Progressing - 80%”, specify the category to  

Documentation, and assign it to susie.parker. 

11. Review the Team Development dashboard. 

Catch Up 

If you haven’t completed Practice 2-1, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_admin user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_02_01.sql file in the /home/oracle/labs/solutions 

directory. 

e. Run the script by clicking the Run icon. 

f. Click Run Now. 

g. Make sure that the script executed successfully and the apex_dev user is created. 

 

If you haven’t completed Practice 2-3: Installing a Sample Dataset, perform the steps to install a 

sample dataset before you start with Practice 21-1. 

 

If you haven’t completed Practice 16-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to SQL Workshop and select SQL Scripts. 

c. Click the Upload > button. 

d. Browse and upload the sol_16_02.sql file in the /home/oracle/labs/solutions 

directory. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Click Install. 

i. Click Edit Application. 

j. On the Application’s home page, click Shared Components. 

k. On the Shared Components page, click Application Access Control.  

l. Click on the Roles and User Role Assignments tab. You see that no user or user roles are 
imported when you imported the application.  

m. Sign out of Application Express. 

n. Sign in to the Application Express workspace as the apex_admin user. 

o. Click the arrow next to SQL Workshop and select SQL Scripts. 

p. Click the Upload > button. 

q. Browse and upload the createusers_addroles.sql file in the 

/home/oracle/labs/labs directory. 

r. Note that you must change the application ID in the script to reflect your new application ID. 
Click the edit icon and make the necessary change in the script and click Save. 
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s. Click Upload.  

t. Run the script by clicking the Run icon. Ensure that you have selected OEHR schema on 
the top left corner. 

u. Click Run Now.  

v. Make sure that the script executed successfully and three users (brad.knight, 

susie.parker, and john.bell) are created with their respective roles as 

ADMINISTRATOR, CONTRIBUTOR, READER. Now, if you go to the Application Access 
Control link and click on the Roles and User Role Assignments tab, you see that the 
above users are created with their respective roles. 

 

If you haven’t completed Practice 20-2, perform the following steps: 

a. Sign in to the Application Express workspace as the apex_dev user. 

b. Click the arrow next to Application Builder and select Import. 

c. Click the Browse button. 

d. Browse and open the sol_20_02.sql file in the /home/oracle/labs/solutions 

directory and click Next >. 

e. Click Next >. 

f. Select Reuse Application ID 111 From Export File for the Install As Application option 
and click Install Application. 

g. Click Replace Application (if prompted). 

h. Make sure that Yes is selected for the Install Supporting Objects option and click Next >. 

i. Click Install. 

j. Verify that the application and the supporting objects are successfully installed. 
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Solution 21-1: Adding and Monitoring Feedback in Your Application 

Overview 

In this practice solution, steps are provided for adding and monitoring feedback in the GMT 

application. 

Note: The solution script (sol_21_01.sql) generated at the end of this practice is just a starting 

point for this practice and not the solution.  

Steps 

1. Create a feedback form for your GMT application. 

a. In the GlobalMart Management Tool application home page, click Create Page >. 

 

b. In the Create a Page dialog, click Feature for Page Type. 
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c. Click Feedback and then click Next>. 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

840  Practices for Lesson 21: Managing Application Feedback 

d. In the Create Feedback Pages dialog, select the following (some are selected by default) 
and click Create.  

 Starting Page Number: 10020 

 Include in Navigation Bar?: Yes. 

 Administration Page Preference: Click Identify an existing page 

 Existing Administration Page: Select 1. (This is the home page.)  

Note: When you create the feedback page, you will notice that the navigation bar will have 

an entry for feedback, and the application feedback will be automatically enabled. 

 

e. The feedback page now opens in Page Designer. The message “Page Created” is 
displayed. Note that Home Page opens in Page Designer with the Feedback region (you 
had selected Page 1: Home) as the Administration page in the above step.  

f. Click the Save and Run Page icon. 
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g. You are redirected to the Sign In page of the GMT application. Enter your username and 
password and click Sign In. 

 

Also, note that 10020 (Feedback), 10021 (Feedback Submitted), 10023 (Manage 
Feedback), and 10024 (Feedback) get created. However, these are all dialog pages, and 
you cannot run them directly. You will get an error message if you try to run them. 

 

 

2. Create the following feedback in your GMT application: 

Feedback # Feedback Text Experience Feedback Type 

1. The date format on the Orders form 

needs to be changed from dd-mm-yy to 

mm-dd-yyyy 

Neutral General 

Comment 

2. Excellent tool. Very user-friendly and 

intuitive UI.  

Positive General 

comment 

3. Error when deleting a line item on an 

order 

Negative Bug 

         4. Add label help text on Orders page. Neutral General 

Comment 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
Ac

ad
em

y 
U

se
 O

nl
y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

842  Practices for Lesson 21: Managing Application Feedback 

a. After signing in to the GMT application, note that the home page now contains a region on 
Feedback. 

 

b. Click the feedback icon  on the navigation bar. 
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c. The Feedback dialog opens. To create the first feedback, enter the following in the 
Feedback dialog:  

 Experience: Click  

 Feedback: Enter The date format on the Orders form needs to be 
changed from dd-mm-yy to mm-dd-yyyy. 

 Click Submit Feedback 
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d. After submitting the feedback, you get the “Feedback Submitted” message. Close the 
dialog to go back to the GMT application home page.  

 

e. To create the second feedback item, click the feedback icon  once again on the 
navigation bar. 

 

f. In the Feedback dialog, enter the following:  

 Experience: Click  to indicate “positive”.  

 Feedback: Enter Excellent application. The UI is user friendly and 
quite intuitive. 

 Click Submit Feedback. 
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g. After submitting the feedback, you get the “Feedback Submitted” message. Close the 
dialog to go back to the GMT application home page. 
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h. To create the third feedback, click the feedback icon  on the navigation bar. 

i. In the Feedback dialog, enter the following: 

 Experience: Click  

 Feedback: Enter Error when deleting a line item on an order. 

 Click Submit Feedback. 
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j. Close the Feedback Submitted dialog by clicking close.  

 

k. To create the fourth and the last feedback, click the feedback icon  on the navigation 
bar. 

l. In the Feedback dialog, enter the following: 

 Experience: Click  

 Feedback: Enter Add label help text on Orders page. 

 Click Submit Feedback. 
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m. Close the Feedback Submitted dialog by clicking close.  

 

n. You have entered all your feedbacks. Now you want to view it in Team Development. Click 
Home on the Developer toolbar. 
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3. Review your feedback in the GMT application home page.  

You can review the feedback in two ways – from the application home page and also from the 

Oracle Application Express > Team Development page.  

You review and manage feedback from the GMT application as an end user:   

a. Select the GlobalMart Management Tool application. 

  

b. Select Run Application. 

   

c. The Home Page opens. You can see that the Feedback section displays the count of the 
feedbacks submitted. You can view the feedback details by clicking User Feedback. 
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d. When you click User Feedback, the Manage Feedback page opens and displays feedback 
details. 

 

e. Click the edit icon  for any feedback that you want to update. The feedback form for 
the specific feedback opens where you can enter your (end user) response and change the 
status. Your (end user) response is visible as “Public Response” in the Developer view. 
Click Apply Changes.  Note that in this activity we have not made any changes. Close the 
Manage Feedback window. 

f. Click Edit Page 1 link on the Developer toolbar. 

 

 

4. Review your feedback in Team Development. 

a. Page 1: Home opens in Page Designer view. Go to Team Development and click 

Feedback. The Feedback Dashboard opens.  
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b. On the Feedback Dashboard, click 111. GlobalMart Management Tool to view the 

feedbacks grouped by application.   

 

The Feedback Report is displayed. Currently the Status column displays 0. No Status.

 Note that you can also see your feedbacks by clicking the Team Development icon  > 

Feedback Entries in Page Designer view. 
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5. Log feedback 1 (“The Date format on the Orders form ….”) as a feature with a status of 

“Functionally complete - 80%.” 

a. Click the Feedback Number 1 link to edit it. 

 

b. The View Your Feedback dialog displays the feedback details. Click Log as Feature. 

 

c. Specify the following and click Create Feature: 

 Feature Name: Enter Date format change 

 New Release: Enter 19.2 

 Assigned To: Select John.Bell 

 Start Date: <Select today’s date> 

 Due Date: <Select the date one month from now> 

 Desirability: Select 3. Desirable (if not selected by default) 
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 Development Priority: Select 3. Normal Priority (if not selected by default) 

 Feature Status: Select Functionally complete - 80% 

 

Notice that assigning a feedback as Feature Bug changes the Status to 4.Closed. 
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6. Acknowledge feedback 2.  

a. Click the feedback 2 link. The View/Feedback dialog opens.  

 

In the View/Edit Feedback dialog, change the Status to 1 – Acknowledged and click 

Apply Changes. 

 Notice the change in the Status column. It displays now as 1. Acknowledged.  
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7. Log feedback 4 (“Add label help text on Orders page”) as a To Do, assign it to susie.parker, 

and change the status to “Assigned - 30%.”  

a. Click the Feedback Number 4 link to edit it. 

 

b. You want to change feedback 4 to an Enhancement Request and a To Do. Enter the 
following: 

 Type: Select Enhancement Request 

 Click Log as To Do 

 

c. In the Convert Feedback to a To Do dialog, specify the following and click Create To do: 

 Release: Select 19.2 

 Assigned To: Select susie.parker 

 To do status: Select Assigned - 30% 
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8. Edit the To Do, changing the status to “Work Progressing - 80%” and specifying Documentation 

for the category. 

a. Click the arrow next to the Team Development pull-down menu and select To Dos. 

 

b. Click Report. 
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c. In the To Do Report, click the Add label help text on Orders page link. 
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d. Change the To Do > Status to Work Progressing - 80%, enter Documentation for 

Details > New Category, and click Apply Changes. 

  

You get the message Action Processed. Notice that the Percent Complete column is 

displayed as 80. 
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9. Log feedback 3 (“Error when deleting a line item on an order”) as a bug. Set the severity to “4. 

Moderate Impact” and assign it to brad.knight. 

a. Click the arrow next to the Team Development pull-down menu and select Feedback. 

 

b. Click the Feedback Entries link. 

 

  
O

ra
cl

e 
In

te
rn

al
 &

 O
ra

cl
e 

Ac
ad

em
y 

U
se

 O
nl

y



 

Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 

860  Practices for Lesson 21: Managing Application Feedback 

c. Click the Feedback number 3 link to edit it. 

 

d. In the View/Edit Feedback dialog that opens, click Log as Bug to mark Feedback 3 as a 
bug. The Convert Feedback to Bug dialog opens. 
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e. In the Convert Feedback to Bug dialog, specify the following and click Create Bug. 

 Severity: Select 3. Significant Impact 

 Release: Select 19.2 

 Assign To: Select brad.knight 
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10. Edit the bug and change the status to 80. Fixed in development and set the priority to 1. As 

soon as possible. 

a. Click the arrow next to the Team Development pull-down menu and select Bugs. 

 

b. Click Report. 

 

c. Click the Error when deleting a line item on an order link. 
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d. On the Bug: 1 details page, enter the following: 

 Status: Select 80. Fixed in development 

 Priority: Select 1. As soon as possible  

 Click Apply Changes 

 

Notice the changes displayed in Status and Priority columns. 
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11. Review the Team Development dashboard. 

a. Click Team Development in the navigation bar. 

 

b. An overview of all your features, milestones, to dos, and bugs is displayed. 
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